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A. Limited Warranty 
 
Laerdal Medical warrants to the purchaser that its product(s) is(are) free from defects 
in material and workmanship for a period of one (1) year from the date of purchase 
by the original user. During the designated one (1) year period, Laerdal Medical will, 
upon receipt of a product found to be defective due to materials or workmanship 
from the purchaser and notification in writing of the defect, at its option repair or 
replace any parts found to be defective or the entire product if repair is not possible. 
 
Products found to be defective and notification of defects may also be sent to the 
authorized Laerdal Medical dealer from whom the product was purchased. All 
postage, shipping or handling charges shall be the sole responsibility of the 
purchaser. 
 
Laerdal Medical is responsible for the effects of safety, reliability and performance of 
its product(s) only if:  
 

• Service, repair, readjustment or modification is carried out by Laerdal Medical 
or persons authorized by Laerdal Medical. 

• Electrical installation of the room where the product is used complies with 
pertinent national requirements. 

• Product is used in the proper manner in strict compliance with its directions for 
use. 

 
Laerdal Medical shall not be liable under this warranty for incidental or consequential 
damages, or in the event any unauthorized repairs or modifications have been made 
or attempted, or when the product, or any part thereof, has been damaged by 
accident, misuse or abuse. This warranty does not cover batteries, softpacks, 
modules, fuses, normal wear and tear, staining, discoloration or other cosmetic 
irregularities that do not impede or degrade product performance. 
 
Some states in the USA do not allow the exclusion or limitation of incidental or 
consequential damages, so those limitations or exclusions may not apply to you. 
There are no other express or implied warranties, whether of merchant ability, fitness 
or purpose or otherwise, on the product, its parts and accessories. 
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B. Cautions and Warnings 
 
Laerdal SimMan should be operated by trained persons. 
Do not connect the product to a patient. 
 
Use of a defibrillator for training purposes represents an operational hazard 
equivalent to use of a defibrillator on a real patient since it involves the release of 
high levels of electrical energy into the training manikin.  
Consequently: 
All safety precautions for use of defibrillators must be followed, as if the manikin were 
a patient. Consult your defibrillator's User Manual. 
� Defibrillation should be performed on the defibrillation connectors only. If 

defibrillation is performed over one or more of the ECG connectors, high 
voltages may be present on the remaining connectors during the shock. 

� To prevent overheating, do not provide more than three (3) defibrillator 
discharges (max 360J) in a sequence. Do not exceed an average of two (2) 
defibrillator discharges per minute during the training session. 

� The manikin must not be in contact with electrically conducting surfaces or 
objects during defibrillation. A flame supporting atmosphere, for example with 
a high content of oxygen, should be avoided during defibrillation.  

� The manikin chest must be kept dry. Special attention should be taken when 
using IV Arm, Urinary system or Bleeding Control Modules. 

� To prevent chest skin electrode pitting, do not apply conductive gel or 
conductive defibrillation pads intended for patient use. 

� Do not use cables or connectors having visible damage.  
� Do not spill fluids over any component inside the manikin torso, since this 

could damage the unit and might also present a possible hazard for the 
operator. 

� If a training session involves the administration of fluids and / or drugs into the 
IV arm, empty the arm immediately following the training session. 

� Do not allow the manikin's skin to come in direct contact with ink or 
photocopied paper, as this can permanently stain the skin. Avoid using 
colored plastic gloves when handling the manikin, as they may also cause 
discoloration. 

� Do not introduce any fluids (except airway lubricant in small amounts to 
lubricate the airway) into the esophagus or trachea of the manikin. 

 
This device generates, uses and possibly radiates radio-frequency energy. If it is not 
installed and used in accordance with the instructions, it may cause harmful 
interference to radio communications. In that case the user is encouraged to attempt 
correction of the interference by: 
 
� Reorienting or relocating the receiving antenna. 
� Increasing the distance between the device and receiver. 
� Connecting the device to an outlet on a circuit different from that to which the 

receiver is connected. 
� Consulting the dealer, or an experienced radio/TV technician, for help. 
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C. Components 
 
The Laerdal SimMan includes the following main components: 

 
Laerdal SimMan Manikin 
SimMan Software CD-ROM for Windows 98, Me, 2000, XP and NT 
Operating Guide Volume I CD-ROM: Set-up / Maintenance / Trouble-shooting 
Remote Control Units (2) 
Pulse Oximetry Probe 
Simulated Patient Monitor 
Link Box 
Set of Defibrillation Studs: 

• Hands Free Defibrillation / Pacing Adaptors (Heartstart and Physio Control) 
• Plates for Manual Defibrillation  

Replaceable Neck Skin Collars (6) 
Roll of Crico-Thyroid Membrane Hy-Tape (2) 
Chest Tube Insertion Modules (6) 
Airway Lubricant 
Upper Dentures (one (1) non-breakable installed, and (3) breakable) 
Replaceable Male and Female Genitalia with Urinary Connection Valves 
Tool Kit, consisting of: 

• Pliers 
• Screw-driver 
• Nut Driver 
• Bolts for attaching legs to body (including locking wing nuts) 

Maintenance/Repair Kit, consisting of: 
• Extra Pneumothorax Bladders  
• Modeling Wax 
• Talcum Powder 

IV Kit, consisting of: 
• Tubing (2) 
• Simulated Blood Concentrate 
• IV Bag (2) 

Blood Pressure Measuring Kit 
Track Suit (jacket and trousers) 
Connection Cables and Tubing, consisting of: 

• AC Line Cord, Simulated Patient Monitor 
• AC Line Cord, Link Box 
• AC Line Cord, Air Compressor (optional) 
• Cable, Link Box to Manikin 
• Cable, Link Box to Simulated Patient Monitor 
• Cable, Link Box to PC 
• Cable for Sounds, PC to Link Box 
• Hose, Manikin Air and CO2 Supply 

 
Pressurized Air and CO2 source (to be purchased separately):  

• Compressor Unit (included in some configurations) 
• or Regulator Unit 
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D. System Features 
 
D.1 SimMan Manikin 
SimMan is a full body, adult male manikin that allows the simulation of Basic and 
Advanced Life Support Skills and Assessment to develop both individual and team 
skills. Hinged joints allow the manikin to be placed in various positions. 
 
D.1.1 Head 
The head allows for performance of head tilt and jaw thrust manuevers; however, the 
airway is open in all positions. 
 
D.1.2 Airway and Lungs 
a) SimMan’s airway is instructor-controlled to allow simulation of various airway 

complications, including the failure of therapeutic airway devices. This 
encourages students to extend their airway management skills beyond those 
used on a daily basis.  

b) SimMan accepts a wide range of airway management devices and techniques. 
Some examples are: 
� Oral / nasal pharyngeal airways  
� Endotracheal tubes - nasal and oral 
� Laryngeal Mask Airways 
� Combitube  
� Needle cricothyroidotomy  
� Surgical cricothyroidotomy 
� Retrograde intubation 
� Fiberoptic procedures 
� Light Wand intubation 
� Bronchoscopy 

c) Ventilation can be performed using any of the following: 
� Bag-Valve-Mask devices 
� Jet ventilation 
� Ventilator 

d) The manikin contains two lungs. Intubation that is too deep will result in unilateral 
lung filling. This usually occurs on the right side, due to the accurate anatomical 
modeling of the tracheobronchial junction and bronchial tree.  

e) The system does not accept PEEP modes of ventilation. 
f) Mouth-to-mouth / nose / mask ventilation should not be performed on SimMan. 

Please note that thorough cleaning of the upper airways, as well as changing the 
lungs will be necessary if mouth-to-mouth / nose / mask has been performed on 
the manikin. 

g) The airway contains a number of instructor-controlled complications:  
� Laryngospasm  
� Posterior Pharyngeal swelling  
� Tongue edema  
� Trismus  
� Verbal response  
� Decreased cervical range of motion 
� Decreased right and / or left lung compliance 
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h) The manikin simulates spontaneous respiration with the following features:  
� Chest rise and fall 
� Exhalation of air 
� Exhalation of CO2 (instructor-controlled) 
� The variable respiratory rate is synchronized to the Simulated Patient Monitor 

display and lung sounds 
� The tidal volumes dynamically alter in line with the selected respiratory rate 
 

D.1.3 Neck 
a) Bilateral carotid pulses. 
b) Airway access through simulated cricothyroid membrane. 
c) Decreased Cervical Range of Motion DCROM (instructor-controlled). 
 
D.1.4 Torso 
a) Anatomically modeled from a human specimen, the torso demonstrates normal 

anatomical surface landmarks. 
b) SimMan has correct anatomical landmarks for external chest compressions. 

Chest compressions will produce carotid pulses, as well as compression artifacts 
on the Simulated Patient Monitor. 

c) Manikin is equipped with separate defibrillation and ECG monitoring connectors. 
The system provides 3- and 4-Lead ECG readings. 
Caution: These connectors are designed for ECG monitoring only. If defibrillation 
is attempted over any of the ECG connectors, high voltages may be present on 
one or more of the uncovered connectors during the shock. (See the "Cautions 
and Warnings" section.) Defibrillation attempts via the electrode monitoring 
connectors will also damage the internal electronics requiring that they be 
replaced. 

d) Manikin is equipped with two defibrillation connectors. ECG signal can also be 
monitored across these connectors. Instructor can, via appropriate keyboard or 
remote control, command / select the “Ignore Defib” function. This determines if 
the defibrillation shock results in conversion to a selected waiting rhythm. Manual 
paddle adapters are supplied for use with manual defibrillators. 
Caution: Defibrillation must be performed only over the two defibrillation 
connectors. (See the "Cautions and Warnings" section.) 

e) Connectors for external pacing are connected to the manikin’s defibrillation 
connectors. Patient pads should not be used, as they do not guarantee sufficient 
contact. The system has a variable pacing threshold and the ability to ‘ignore’ 
pacing. Pacing capture results in a pulse synchronized with the heart rate and the 
display of a paced rhythm on the Simulated Patient Monitor. 

f) The torso contains a number of hidden speakers that allow the realistic 
auscultation of sounds: 
� Lung 
� Heart 
� Bowel 

g) Tension pneumothoraces can be simulated through the inflation of resealable 
bladders. Needle decompression can be performed at: 
� Bilateral mid-clavicular line, 2nd intercostal space 
� Right mid-axillary line, 5th intercostal space 
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h) Chest tube insertion can be simulated, and cut can be made at left mid-axillary 
line at (4th and) 5th intercostal space. 

i) Abdominal distension occurs with normal ventilation while using Bag-Valve-Mask 
or if the esophagus is intubated. 

 
D.1.5 Arms 
 
a) Right Arm is a Multi-venous IV Arm allowing: 
� Cannulation 
� Phlebotomy 
� Drug administration 
� Infusion 
The veins are self-sealing allowing multiple uses; however, repetitive insertions in 
the same area will result in leakage sooner than if the cannulations had been 
spread over a wider area. 
The venous system and the skin sleeve are both replaceable. 
The venous system is fluid filled when charged with simulated blood using a 
closed ‘infusion and drainage’ system.  

b) Left Arm is a BP Arm with radial and brachial pulses and Korotkoff sounds. 
The BP arm allows palpation and auscultation of a blood pressure that can be 
measured automatically on the Simulated Patient Monitor. Auscultation gap can 
also be simulated. 

 
D.1.6 Pulses 
 
a) SimMan has physiologically correct palpable pulses: 
� Bilateral carotid pulse 
� Bilateral femoral pulse 
� Left radial pulse 
� Left brachial pulse  

b) The pulses are synchronized to the simulated ECG and, when activated, the 
external pacemaker upon capture. 

c) Pulses, once activated, will remain on for approximately five (5) seconds before 
reactivation is required. 
Caution: Care should be taken when palpating pulses. Use of excessive force 
results in the inability to feel pulse. 

 
D.1.7 Insert Pads 
 
a) SimMan contains bilateral thigh, gluteal, ventro-gluteal and right deltoid insert 

pads.  
b) The pads can be used for intramuscular and subcutaneous injection practice. 
c) These can be interchanged with optional trauma or nursing wound modules. 
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D.2 SimMan Software 
 
The SimMan Software serves as the instructor's tool for controlling the training 
scenario. It requires a Pentium computer with MMX processor, 233MHz or better, a 
minimum of 128 MB of RAM with 150MB available on the hard disc, Windows 98 / 
Me / 2000 / XP / NT, and a CD-ROM drive with minimum speed of 4x. 
The software features are: 

a) Training controls via computer keyboard and / or remote controls 
b) Over 2,500 ECG rhythm variations 
c) Variable extrasystole rate 
d) Choice of various extrasystole types 
e) Variable pacemaker threshold (external pacemaker training only) 
f) Control of manikin functions 
� Airway complications 
� Tension pneumothorax 
� Breathing 
� BP - NIBP and Arterial 
� SpO2 simulation 
� Temperature display 

g) Auscultation sounds  
� Lung 
� Heart 
� Bowel 

h) Vocal sounds  
� Numerous vocal sounds are available (moan, vomit, cough, etc.) 
� Additional sounds can be recorded by the user  
� Microphone option (instructor may speak directly through the manikin’s on 

head speaker by using the microphone) 
i) Left / right or bilateral lung obstruction 
j) Pulse strength 
k) Activity Log 
l) Scenario Builder / ECG sequence builder for your own training scenarios 
m) Trend Editor 
n) Event Handler 
 

D.3 Link Box 
 

a) The computer connects to the manikin via the Link Box.  
b) 12 V DC, or 110 – 240 V AC operation 
c) Remote-controlled interface connectivity to: 

� Manikin 
� Simulated Patient Monitor 
� BP arm on manikin 
� External speakers 
� Computer headphone to link audio (sounds) 
� SpO2 probe 
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D.4 Air and CO2 Source 
 
Compressed air is provided by a compressor or other type of pressurized air source 
via a regulator unit, allowing many functions to take place: 

• Airway complications 
• Spontaneous breathing 
• Tension pneumothorax inflation 
• Carotid pulse 

a) 110 – 240 V AC operation  
b) CO2 source 
c) Connects to alternate compressed air source 

 
D.5 Simulated Patient Monitor 
 
The Simulated Patient Monitor provides concise clinical feedback of physiological 
parameters. All parameters are instructor-activated with the ability to set a lower and 
higher alarm limit for every parameter shown on the monitor. The monitor may be 
configurred to display the desired parameters and curves and it is possible to save 
and retrieve five (5) configurations. Colors and curve trace speeds can also be 
changed. The CO2 curve has by default a slower trace speed.  
a) 110 – 240 V AC operation 
b) Simulated patient information (synchronized with all other clinical outputs) 
� ECG  
� Arterial blood pressure waveform 
� CO2 and capnograph waveform 
� Heart rate related to SpO2 
� BP – with timed automatic updating and ‘BP now’ function 
� Respiratory rate  
� Temperature 
� SpO2 waveform and numerical display with audio output 
� CVP waveform and numerical display output 
� TOF 
� TOF% 
� CO 
� FIO2 
� FIN2O 
� FI Anesthetic agent 
� ETO2 
� ET Anesthetic agent 
� Core temperature 
� Peripheral temperature 
 

Please note: Because all information is simulated rather than actual, the 
parameters, with the exception of ECG, cannot be “measured or displayed” on 
clinical equipment. 
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E. Software Installation 
 
Installing the Laerdal SimMan software on your PC: 
 
Laerdal SimMan software requires Windows Installer 1.1 for installation. This will 
automatically be added to your system if needed and may require a restart of your 
computer. Installation of Laerdal SimMan software will proceed after restart. Follow 
the on-screen instructions. 
 
• Insert the Laerdal SimMan CD in your CD-ROM drive. 
• If your CD-ROM is set up for Auto run, the installation program will start 

automatically. 
• If your CD-ROM is not set up for Auto run, start the installation program by 

clicking “Run” on the Start menu, and typing d:\setup.exe (where “d” is the 
drive letter of your CD drive). 

• Then click “OK” or press “ENTER”. 
• On the Installation Start-up screen, click "Install SimMan". 
• Follow the on-screen instructions for installation. 
 
After the Laerdal SimMan software has been installed, Microsoft Java Virtual 
Machine will automatically be installed on your PC. 
This installation will require you to restart your computer before the installation is 
complete. 
 
For the Laerdal SimMan Help to function correctly, Microsoft Internet Explorer 4.01 
SP1 or newer must be installed on your computer. If you are running a Windows 98/ 
Me/ 2000 / XP operating system, this is already installed. You can install the English 
version of Microsoft Internet Explorer 5.5 from the Laerdal SimMan CD by clicking 
"Install Internet Explorer". Local versions of Internet Explorer can be obtained from 
the Microsoft web site, www.microsoft.com . 
 
The Internet communication protocol TCP/IP must be installed on the computer for 
the Laerdal SimMan program to run. Windows 98/ Me/ 2000 / XP come with TCP/IP 
installed, so normally you will not need to install it; however, if using Windows NT 
you may be required to install it. 
 
See information below for installing TCP/IP. 
 
To start Laerdal SimMan software, double-click the SimMan desktop icon. 
 
 
Note for Windows 98 / Me users: 
If several users will be logging into your computer, each user may be required to run 
the Laerdal SimMan software installation separately. 
This will depend on your Windows user profiles settings. 
See information below for details (Multi-User Installation Notes). 
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Note for Windows NT / 2000 / XP users: 
You must be logged into Windows with administrator rights to install the Laerdal 
SimMan software. The installation program will let you choose between installation 
for all users or for the current user only. 
 
 
TCP/IP 
 
If the PC is setup for Internet usage, TCP/IP is already installed. 
Windows 98 / Me / 2000 / XP are by default, Internet ready and come with 
TCP/IP pre-installed. 
 
If TCP/IP is not installed, you should follow these steps: 
 
1. If you are connected to a network, consult your network administrator. 
 
2. If you are not connected to a network: 

• Be sure to have your Windows installation CD or floppy disks available 
• Install Laerdal SimMan software and Internet Explorer by following the loading 

instructions. 
• Go to the Start menu, select Programs and the Internet Explorer folder and 

then select Connection Wizard. You will be presented with a number of choices 
• Select "I want to set up a new connection on this computer to my existing 

Internet account using my phone line or local area network (LAN)".  
• Click "Next". 
• Select "Connect using my phone line".  
• Click "Next". 
• The necessary files will be installed (you may be prompted for Windows 

installation disks). 
• When prompted for modem, click "Cancel" and exit the Connection Wizard. 
• Restart Windows. 

 
You should now be ready. Double-click the SimMan desktop icon to start the Laerdal 
SimMan program. If the Connection Wizard starts again, select "My computer is 
already set up for the Internet. Do not show this wizard again".  

• Click "Next". 
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3. Alternatively, and only recommended for expert users, you can use Control 
Panel to install TCP/IP. (You must have Windows CD or disks available): 

   In the Network setup: 
      - Add "Microsoft Dial-up adapter"  
      - Add "Microsoft TCP/IP protocol"  
 
In this case, select "My computer is already set up for the Internet. Do not show this 
wizard again" when prompted by the Connection Wizard. 
 
 
Multi-User Installation Notes 
 
If you run a Windows 98 / Me operating system, you may be required to install the 
Laerdal SimMan software for each user who will be running Laerdal SimMan 
program. This depends on the User Profiles settings in the Passwords Properties 
Dialog found in the Control Panel. 
 
If User Profiles is NOT turned on (default), SimMan is installed for all users. 
Every user that logs into Windows will see the same programs. 
 
If User Profiles is turned on, Laerdal SimMan software is installed only for the current 
user. 
The users may see different programs installed on the system. 
 
It is recommended that you log into Windows rather than clicking cancel in the 
Windows log-in window, before installing the Laerdal SimMan software. If you do not 
log in before installing, you might get the following error message when you try to run 
the Laerdal SimMan program at a later time (when you log in to Windows with a user 
name): 
 
'The Managed Software Installer failed to install the program associated with this file. 
Please contact your system administrator.' 
 
or: 
 
'This application must be installed to run. Please run setup from the location where 
you originally installed the application.' 
 
To fix the error, start Laerdal SimMan installation from the Laerdal SimMan CD-ROM 
and reinstall the Laerdal SimMan software. This will activate the program for the 
current user. 
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F. Assembly and Setup of Laerdal SimMan System 
(See the Operating Guide CD-ROM for further details.) 
 

F.1 Attaching the Legs: 
1) Locate bag containing attachment hardware.     
2) Remove insert pad from upper leg. 
3) Lift genitalia and reservoir section out of the pelvis of the 

manikin. DO NOT remove upper abdominal section. 
4) Place a washer, a spring and another washer onto threaded 

15cm (6”) bolt. 
5) Insert threaded bolt through upper leg, through hole in hip 

and into internal cavity of lower pelvic area. 
6) From inside pelvic area, slip a washer on the bolt. 
7) Screw a locking wing nut (provided) onto bolt and 

tighten until desired articulation is achieved. 
8) Replace genitalia, urinary reservoir and insert pad. After 

replacing the genitalia and urinary reservoir, make certain 
that the pelvic pin has been replaced. 

9) To remove leg(s), reverse the procedure. 
 
F.2 Crico-Thyroid Membrane Hy-Tape 

1) Expose neck to visualize opening that has been 
molded in place of crico-thyroid membrane. 

2) Remove used Hy-Tape from opening. 
3) Cut a 4cm (1 ½ ") strip of Crico-Thyroid 

Membrane Hy-Tape and apply it over the 
opening to create simulated membrane. 

4) A tight seal will enhance actual feel and sound 
of crico-thyroid membrane penetration.  

 
F.3 Neck Skin Collar 

1) Lay a neck skin collar, with dull side out, into molded track around neck area 
of trainer. 

2) Attach collar ends together. 
3) The collar is designed to provide multiple sites for needle and surgical 

techniques. When a fresh site is needed, rotate the collar in either direction. 
 
F.4 Link Box 
The Link Box connects the manikin to the computer.  
To connect (also see connection guide on page 17): 

1) Attach manikin cable to right lower side of manikin’s torso and to the 
connector marked “Manikin” on the back of the Link Box. 

2) Connect serial cable to connector marked “PC” on the back of the Link Box 
and to serial port on back of your computer. If your computer has USB 
connectors only and does not have a serial port, you need a “USB to serial 
adaptor” (to be sourced locally). 

3) Connect other serial cable to connector marked “Monitor” on the back of the 
Link Box and to COM2 port on back of the Simulated Patient Monitor. 

4) Connect clear tubing from blood pressure cuff to the inlet marked “BP cuff” on 
the back of the Link Box.  
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5) Connect the SpO2 cable to the SpO2 connector on the back of the Link Box. 
6) Connect one end of the audio cable to the connector marked “Audio input” on 

the back of the Link Box and the other end with the mini-jack plug into the 
headphone outlet of your computer. 

7) Plug the Link Box AC power cable into a power supply (110-240 V AC).  If you 
are using the Portability Kit, attach to the 12 V DC input according to the 
Portability Kit instructions.  

8) Connect external speakers, if used, to connector marked "Ext. speaker" on 
the back of Link Box. 

 
F.5 SpO2 Finger Probe 
The SpO2 finger probe provides enhanced realism for the care provider by simulating 
the use of an actual pulse oximeter probe. When the probe cable is connected to the 
Link Box, SpO2 will not be displayed until the probe is placed on one of the manikin’s 
fingers. If the probe is not attached to the Link Box, SpO2 will only be displayed 
automatically when selected by the user through the instructor panel on the PC. 
 
F.6 Simulated Patient Monitor 
The Simulated Patient Monitor allows any or all of the patients’ status data (ECG, 
Heart Rate, Arterial BP waveform, NIBP, Temperature, SpO2, CO2, CVP etc.) to be 
displayed. To connect, attach one end of the supplied cable to the COM2 port on the 
back of the Simulated Patient Monitor, and the other end to the Link Box. Plug the 
Simulated Patient Monitor into a power supply (110 V or 230-240 V AC). A monitor 
stand is included and separate mounting instructions are located in carton. 
 
F.7 Air and CO2 Source (optional) 
 
F.7.1 Option 1: Compressor Unit 
If you have purchased Laerdal SimMan with a Compressor Unit, attach one end of 
the double lumen tube into the compressor and the other to the right axillary side of 
the manikin.   
 

Starting the Compressor: 
1) Check Compressor Unit for transport damage. 
2) Check that Power Switch (4) is set to off position “0”. 
3) Plug power supply cable into plug (5) in Compressor panel. 
4) Plug power supply cable into power source. 
5) Connect all hoses to SimMan. 
6) Check that drain valve (1) is closed (hand tighten only!). 
7) Close Air valve (2) and CO2 valve (3) (blue valves in middle of panel). 
8) Push Power Switch (4) to on position “1”, the compressor will start and run for 

approximately 45 seconds to build pressure in tank. 
9) When the compressor stops, the Laerdal SimMan is ready for use.   

Open Air (2) and CO2 (3) valves. 
10) Jet ventilation (TTJV) feature is also included and requires a special connector 

(available for purchase using part number 381201). 
11) The compressor will start and stop with different intervals depending on 

consumption of air. 
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Shutting the compressor down after use: 
1) Push Power Switch (4) to off position “0”, the compressor will stop if running. 
2) Open Drain valve (1) to drain air out off system. 
3) Close Drain valve (1) and disconnect all hoses. 

 

 
 
Warning: 
Do not open Compressor Box when energized, it contains high voltage. The 
compressor should only be repaired by authorized personnel.  
 
F.7.2 Option 2: Regulator Unit 
 
If you have purchased Laerdal SimMan with the Regulator Unit, attach one end of 
the double lumen tube to the “Air/CO2 out to Manikin” outlet on the regulator and the 
other end to the right axillary side of the manikin. Connect the “Air in” inlet to a wall 
air outlet or to a pressurized air canister (70-120 psi). If simulated exhaled CO2 is 
desired, connect the “CO2” inlet to a pressurized CO2 canister (60-90 psi). Jet 
ventilation (TTJV) requires a special connector (available for purchase using part 
number 381201). 
 

 



6895 rev F  Laerdal Medical 2002 page 16 of 125 



6895 rev F  Laerdal Medical 2002 page 17 of 125 

 
G. Instructions For Use 
 
G.1 Airway Management 
Using the computer user interface or the appropriate remote control, the following 
airway functions may be activated and deactivated: 
� Pharyngeal Obstruction 
� Tongue Edema 
� Trismus 
� Laryngospasm 
� Decreased Cervical Range of Motion 
� Decreased Right/Left Lung Compliance 
� Pneumothorax 
� Stomach Decompression 
� Can’t Intubate, Can Ventilate 
� Can’t Intubate, Can’t Ventilate 
� Exhale CO2 
� Variable breathing rate 
� Apnea 
� Variable pulse oximeter display 
� Breath sounds 

 
 
 
 
 
 
 
 
The Laerdal SimMan contains a unique patented difficult airway. Correct form and 
technique are required to perform direct laryngoscopy and endotracheal intubation. 
Correct use of a variety of airway adjuncts will successfully ventilate the patient 
simulator. When airway adjuncts are used, ventilation may be made more difficult by 
activating decreased lung compliance for either the right lung or left lung. Activating 
decreased lung compliance for both lungs causes airway adjuncts to fail to ventilate. 
 
Special notice regarding laryngoscopy and the use of airway adjuncts: 
 
Endotracheal Tubes 
While ET tubes as large as 8.5 may be used, we recommend the use of ET tube size 
7.5 to extend the life of the simulator. We also recommend the use of a malleable 
stylette. Care should be taken, as with any direct intubation, that the stylette does not 
extend beyond the end of the tube. 
 
Laryngeal Mask Airway (LMA) 
The Laerdal SimMan will allow use of the LMA Classic, LMA Unique and LMA 
Fastrach. Although a #5 LMA may seal correctly, the airway has been designed for 
use with a #4 LMA. The following procedure should be followed when an LMA is 
used: 

Important: Prior to using airway adjuncts, spray the inside of the 
pharynx, nostrils and all airway management devices to be 
inserted with a liberal amount of the provided airway lubricant.   
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� For the LMA to successfully ventilate the simulator, the instructor should 
observe the care provider as the #4 LMA is inserted.   

� When the care provider inflates the cuff of the LMA, the instructor should 
simultaneously activate pharyngeal obstruction. This not only allows the LMA 
to obtain a proper seal, it also causes the LMA to retract slightly from the 
pharyngeal cavity, as seen in most actual clinical uses of the device. 
Activating the stomach distention function will also create a better chest rise. 

� The instructor can cause the LMA to fail to ventilate, by either deactivating 
pharyngeal obstruction or activating decreased lung compliance for both right 
and left lungs. 

 
Combitube 
The Laerdal SimMan will allow the use of the Combitube, as it will successfully 
ventilate the “patient”. We recommend the use of the Combitube trainer, as it will 
generally withstand multiple uses. The Combitube trainer is sized the same as a 
large adult Combitube. Although a small adult size Combitube may work with varying 
success, the Combitube trainer provides more cost-effective training and reliability of 
function. 
 
The instructor can cause the Combitube to fail to ventilate, by activating decreased 
lung compliance for both right and left lungs. 
 
G.2 Chest Drain / Chest Tube 
The Chest Tube insertion module is located at the left mid-axillary site. This module 
allows chest tube insertion to be performed. A cut can be made at left mid-axillary 
line at the (4th and) 5th intercostal space. To replace the used Chest Tube insertion 
module, simply remove from its location and add a new one with the opening 
positioned toward the shoulder. 
 
G.3 Circulatory Skills and IV Drug Administration 
The IV arm can be used with simulated blood by attaching the supplied IV bag tubing 
to one of the two latex vein openings near the top of the arm. Using the supplied 
simulated blood concentrate, mix the desired volume of simulated blood and add to 
the IV bag. Release simulated blood until it runs via the tubing into the arm and out 
the other latex vein. Once fluid is running freely out of the second vein, seal it using a 
clamp. Using an 18 gauge (or smaller) needle for IV training increases the life of the 
IV arm skin. If you want the student to infuse medicines, attach a second IV bag for 
free flow. 
 
G.4 IM / SC Injections 
The insert pads are foam filled and can be injected with fluids. The foam is 
removable and should be squeezed out as a sponge and allowed to air dry 
immediately following the practice of these procedures. Powdering foam pads with 
talcum powder eases reinsertion into the skin. 
There are five sites for subcutaneous and intramuscular injections, including right 
deltoid, right thigh, gluteal, left thigh, and ventro-gluteal. Using a 22 gauge (or 
smaller) needle increases the longevity of the "skins". 
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G.5 Blood Pressure Arm 
Blood pressure settings are controlled using the computer or remote control. These 
settings are also linked to the ECG functionality, so if you are changing the rhythm 
from a perfusing rhythm to a non-perfusing rhythm, this will also be reflected on the 
blood pressure settings, which will be changed according to the new type of rhythm. 
A non-perfusing rhythm will also change breathing rate (BR) to zero. When changing 
to a perfusing rhythm, the blood pressure will remain at 0/0 until changed, breathing 
rate can not be changed until blood pressure has been established. 
 
G.6 Laerdal SimMan Software 
Using the computer user interface or the appropriate remote control the Laerdal 
SimMan Software allows the operator to select and control the following patient 
functions: 
� Breathing (Respiratory) Rate 
� Heart Sounds 
� Lung Sounds 
� Bowel Sounds 
� Vocal Sounds 
� Patented Expert Difficult Airway functions 
� Over 2,500 ECG rhythm variations 
� Systolic and Diastolic blood pressure values  
� Pulses 
� SpO2 & CO2 
� Temperature 
� All data displayed on the Simulated Patient Monitor 

 
The remote controls are used as described below: 
1) Remote I: Primary cardiac functions and other miscellaneous items 
2) Remote II: Primary airway functions and other miscellaneous items 
 
For complete operating instructions, please refer to the PC User Interface section of 
this manual. 
For details regarding import and export of files and recording of sounds, please refer 
to your Windows manual and Windows help files. 
 
G.7 Needle Decompression 
We recommend a 22 gauge needle for decompression of the chest. Using a smaller 
gauge needle increases the longevity of the chest skin and bladders. 
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H. Repair and Replacement Instructions 
 
H.1 Tension Pneumothorax Decompression – Bilateral Mid-Clavicular Sites 
 

To repair (a vulcanizing / contact cement is needed): 
1) Remove skin at shoulder sides, mid-clavicular, and remove bladder from site 

cavity. 
2) Cover the surface of the pneumo bladder with vulcanizing / contact cement 

(not included). Avoid getting contact cement on chest plate. 
3) Allow to air dry completely. 
4) Replace bladder and chest skin over torso and secure skin at the shoulders 

and both sides. 
5) Fill puncture marks on exterior of chest skin with modeling wax, supplied in 

repair kit, by applying firmly with fingertip while stretching skin. 
 

To replace: 
1) Remove skin at torso sides. 
2) Lift the chest plate exposing its underside. 
3) Disconnect bladder hose from in line hose connector. 
4) Remove bladder from site cavity by pulling it from top side of chest plate. 
5) Insert new pneumo bladder into site cavity and reconnect to the inline hose 

connector by threading it through from top side of chest plate. 
6) Replace chest plate. 
7) Replace chest skin over torso and secure skin at the shoulders and both 

sides. 
8) Fill puncture marks on exterior of the chest skin with modeling wax, supplied 

in repair kit, by applying firmly with fingertip while stretching skin. 
 
H.2 Tension Pneumothorax Decompression - Right Mid-Axillary Site 
 

To repair (a vulcanizing / contact cement is needed): 
1) Remove skin at torso side. 
2) Remove flesh colored box from mid-axillary side 

of manikin. 
3) Remove pneumo bladder from the box. 
4) Cover surface of pneumo bladder with 

vulcanizing / contact cement (not included). 
5) Allow to air dry completely. 
6) Fold bladder and replace in box, return box to 

torso. 
7) Replace chest skin over torso and secure skin at the shoulders and both 

sides. 
8) Fill puncture marks on exterior of chest skin with modeling wax, supplied in 

repair kit, by applying firmly with fingertip while stretching skin. 
To replace: 

1) Remove skin at torso side. 
2) Remove flesh colored box from mid-axillary side of manikin. 
3) Remove pneumo bladder from box. 
4) Disconnect bladder hose from in line hose connector. 
5) Remove bladder from site cavity. 
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6) Insert new pneumo bladder into site cavity and reconnect to in line hose 
connector. 

7) Fold bladder and replace in box, return box to torso. 
8) Replace chest skin over torso and secure skin at the shoulders and both 

sides. 
9) Fill puncture marks on exterior of chest skin with modeling wax, supplied in 

repair kit, by applying firmly with fingertip while stretching skin. 
 
H.3 Chest Drain - Left Mid-Axillary Site 

 

To replace chest tube insertion module: 
1) Remove skin at torso side and left shoulder. 
2) Remove chest tube insertion module from mid-axillary side of manikin. 
3) Insert new chest drain module. 
4) Replace chest skin over torso and secure skin at the shoulders and both 

sides. 
 
H.4 Breathing Bladder 
 

To replace bladder: 
1) Remove skin at torso sides. 
2) Lift out the chest plate. 
3) Fold the lungs upward. 
4) Remove foam part. 
5) Disconnect bladder tubing from nipple on manifold-block. 
6) Connect new bladder to same nipple. 
7) Replace foam, lungs and chest plate. 
8) Replace chest skin over torso and secure skin at the shoulders and both 

sides. 
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H.5 IV Arm 
 

When excessive leaking occurs at the puncture sites, a new vein and skin should be 
installed to reduce loss of fluid. Ideally, the skin and veins should be replaced near a 
sink. 
 

To remove the arm: 
1) Remove deltoid pad from arm. Disconnect the attachment hardware arm 

using a screwdriver.   
2) If replacing both skin and veins, cut 

skin off and discard. The thumb will 
detach with the skin (new skins come 
standard with thumb installed).  

3) If the skin is not damaged and you wish 
to reuse it, lubricate inside of skin with 
liquid detergent. Beginning at the top of 
the arm, roll the skin down and off arm 
and hand. 

4) Remove old veins and discard. 
5) Use acetone or equivalent to remove 

spots of old glue from vein grooves. Dry 
and swab grooves with alcohol. Place 
new veins along grooves, extending both 
veins beyond arm at least 10cm (4”) 
allowing room for connections. Spot glue 
veins as needed. We recommend using 
“Vynabond” or “VLP” from PDI (Plasti Dip 
International), “PL 400” from Tremco or an 
equivalent. 

 
To replace skin: 

1) Roll top of skin down to the hand. Spread 
liquid detergent generously over lower part 
of the arm. Holding skin and arm with palms 
upward, slide hand into skin, working the 
skin over the fingers as with a glove. Then, 
roll the skin up the arm. 

2) Reattach arm when finished. 
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I.  Care and Maintenance 
 

A. Do not introduce fluids into the torso area or left (BP) arm of the manikin, as 
electronic components may become damaged. 

B. Clean with mild soap and water. DO NOT SUBMERGE MANIKIN. 
C. Modules and all other parts should be drained and air-dried thoroughly prior to 

storage. Disinfectants should be used when appropriate. 
D. All subcutaneous and intramuscular injection pads should be squeezed to 

eliminate excess water. To prevent mildew and mold, the foam filling should 
be soaked in a mild solution of bleach and water or a 1 % Laerdal High Level 
Manikin Disinfectant solution. Squeeze the solution out and allow the filling to 
air dry prior to reinsertion and storage. 

E. Articulating parts will benefit from a light application of talcum powder prior to 
training sessions. 

F. Powdering inside of chest skin with talcum powder decreases “plastic sound”. 
G. Use on clean surface only. AVOID FELT TIPPED MARKERS, INK PENS, 

ACETONE, IODINE OR OTHER STAINING MEDICATIONS, AND PLACING 
THE MANIKIN ON NEWSPRINT OR INKED LINES OF ANY KIND. 

H. A general inspection should be conducted regularly. Do not use the product if 
cables or tubings have signs of damage. 

I. Store properly between teaching sessions. If stored in hard cases, disconnect 
cables and tubings and remove legs. The different parts should be correctly 
positioned before closing the cases. 

J. Students should wash their hands prior to using the simulator and wear 
gloves when using the simulator. Treat SimMan as you would a real patient. 

K. Air filter in compressor should be replaced every two years. Directions for 
replacement are part of the Technical/Service manual. 

L. A Technical/Service manual is available for purchase using part number 
381950. 

 
 
J. Standards / Approvals 
 
The product is CE-marked and in compliance with essential requirements of council 
directive 89/336/EEC; EMC – directive. 
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K. Parts / Accessories List 
 

K.1 Accessories 
1005146 Tubing Assy 40ft Compressor-Manikin, Air/CO2  

1005163 Audio Cable 25 ft, PC-Link Box  
1005164 Cable Assy 25 ft, Manikin-Link Box (15-pin D-sub)  
381200 Compressor 230 V  
381201 Jet-Vent Adapter Kit  

381210 Compressor 110 V  
381220 Regulator Unit for Fixed Air Supply  
381450 Nursing Wound Module Set See also Optional features 
381500 Trauma Module Set See also Optional features 
381550 Bleeding Control Module Set See also Optional features 
381600 Transportation Cases  
381850 Portability Kit  
381950 Technical/Service Manual  
 
 

K.2 Consumables 
1005128 Multi-vein System, IV Arm  

1005129 Maintenance/Repair Kit  
1005131 Tape Crico-Thyroid (1 roll)  

1000722 Blood Concentrate, 4oz  

1000262 Silicone Liquid, 4 oz  
252090 Airway Lubricant (glycerol version)  
312029 Skin & Vein, IV Arm  

380405 Bladder Assy Mid-Clavicular (Pneumothorax Chest)  

380406 Bladder Set Mid-Axillary (Pneumothorax Side)  

381105 Neck Skin (pkg.6)  

381106 Teeth Upper Rigid (polyester)  

381107 Teeth Upper Soft (vinyl)  

383110 Chest Tube Insertion Modules (pkg.6)  
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K.3 Spare Parts 
260305 Power-cord (US)  
260306 Power-cord (EUR)  
260307 Power-cord (UK)  
271500 Cable 9-pin D-sub (PC/Monitor to Link Box)  

380110 Remote Control, Cardiac  

380111 Remote Control, Airway  

380200 Arm Assy, Blood Pressure  

380210 Cuff Assy, Blood Pressure  

380310 Cable Assy, Manikin-Link Box (15-pin D-sub)  

380410 Post Set, ECG/Defib  

380435 Breathing Bladder  

380455 Chest Skin with Chest Drain  

380600 Leg Assy Plain, left  

1005162 Thigh Pads, set of 2  

380650 Leg Assy Plain, right  

380700 IV Arm, right  

380810 Pad Set, Shoulder and Hip  

380901 Jacket  

380902 Trousers  

381010 Tubing Assy, Compressor-Manikin, Air/CO2  

381100 Head Assy without Bronchial Branches  

381101 Head Skin w/Airway  

381102 Fasteners for Neck Skin (pkg.10)  

381150 Audio Cable  

381300 Pulse Oximeter Probe  

381900 Directions for Use  
389200 Operating Guide Volume I (CD-ROM)  

500510 Air filter/Silencer for Compressor 381200/381210  
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L. Optional Features 
 
 
Nursing Wound Module Set (381450) including: 
• Abdominal Packing Module 
• Abdominal Incision Module  
• Abdominal Module with Sutures & Drain 
• Abdominal Module with Staples & Drain 
• Chest Incision Module with Staples 
• Sutured Thigh Module 
• Thigh Packing Module 
• Thigh Debridement Module 
• Varicose Leg Module 
• Diabetic Foot Module 
• Gluteal Ulcer Module 
• Ventral Gluteal Ulcer Module 
• Infected Stoma 
• Lacerated Palm Module 
• Upper Arm Module 
• Leg Stump 
 

 

Trauma Module Set (381500) including: 
• Trauma Head Cover 
• Right Crushed Foot 
• 1st, 2nd, 3rd degree burn sleeve 
• Deltoid Pad – small caliber entry wound 
• Deltoid Pad – large caliber entry wound 
• Deltoid Pad – small caliber exit wound 
• Deltoid Pad – large caliber exit wound 
• Impaled object pad  
• Open fracture pad 
• Compound fracture leg 
• Contused ankle assembly 
• Fractured clavicle lay-on  
• Exposed viscera module   

  

 

Bleeding Control Module Set (381550) including: 
• Bleeding Control Thigh 
• Bleeding Amputation Thigh 
• Bleeding Amputation Arm 
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1 Software – How-to Guide 
The How-to Guide is a quick reference for finding answers to questions that may not easily be found 
in the table of contents. 
 

1.1 Software Usage Questions 

1.1.1 General Questions 
What are users and how do I manage them? See 2.1 
How can I ensure that all components are up and running? See Appendix II.c 
Head speaker sound is poor, how can I optimize it? See Appendix III. 
I want to import a scenario, where do I place the files? See Appendix I.c 
 

1.1.2 SimMan Patient Monitor Questions 
How do I get waveforms on the monitor? See 2.7.3 
It is hard to use the touch screen on the patient monitor, how can I make it 
better? 

See 2.14.5 

How do I configure the patient monitor? See 6.2 
 

1.2 Startup Error Messages 
SimMan Link Not Found. See Appendix II.c 
SimMan Fatal Error: SimMan could not establish contact with the SimMan 
host program. 

See Appendix II.c 

 

1.3 First StartUp After a SimMan Software Upgrade 
The first time SimMan is started following an upgrade, a dialog box will 
appear giving you the option to automatically copy the new Scenario, Trend, 
and Handler files to all users. 

See Appendix I.c 

 

1.4 General Operation 
The SimMan SW makes use of general Windows operating techniques. 

1.4.1 ToolTips 
When the mouse is moved over an item on the SimMan screen, an 
identifying ToolTip will usually appear. 

1.4.2 Copy and Paste 
The SimMan SW supports copy and paste functions for large text fields, such 
as entering a description when saving a scenario or entering a comment 
when saving a student log. 
 

 

There are several ways to achieve copy and paste. The simplest may be to 
use CTRL+C to copy the selected text to the Windows clipboard and then 
use CTRL+V to paste from the clipboard again to where the cursor is. 

 

1.4.3 Using keyboard to enter numbers 
When entering a number using the keyboard, you must press the ENTER 
key to complete your change. 
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1.5 Abbreviations 

1.5.1 Monitor Parameters 
ECG Electro Cardio Gram 
HR SpO2 Heart rate calculated based on SpO2 
CO Cardiac Output 
ABP Arterial Blood Pressure 
NIBP Non-Invasive Blood Pressure 
SpO2 Pulse Oximetry 
C. Temp Core Temperature 
Temp Core Temperature 
P. Temp Peripheral Temperature 
TOF Train of 4 responses. How many responses out of 4. 
TOF % Ratio between the strength of the fourth response and the first. 
FI O2 Inspired Oxygen Fraction 
FI N2O Inspired Nitrous Oxide Fraction 
FI Anes. Inspired Anesthetic Gas Fraction 
ET O2 End-Tidal O2 
CO2 End-Tidal CO2 
ET N2O End-Tidal N2O 
ET Anes. End-Tidal Anesthetic Gas 

 

2 SimMan Main Program 

2.1 Log In 
When starting the SimMan program, the user must first log in. This allows several users to share one 
computer and each have their individual setup and set of scenarios and trends. A single user can also 
choose to log in as different usernames to have different setups for different situations, e.g., 
anesthesiology, emergency physicians, nursing, paramedicine, difficult airway, respiratory, etc. 

2.1.1 Initial Log In 
The first time SimMan is started, a new user must 
be created. (This is not necessary if SimMan is 
being upgraded.) This is the new SimMan User 
dialog. Passwords may be blank. 

 

2.1.2 SimMan Log In 
Once you have created a user name, this is the 
ordinary SimMan log in screen that will be 
displayed when you log on to the system. 
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2.1.3 Administrator Tasks 
Enter administrator mode to give users who 
forget their passwords new ones or to delete no 
longer needed users. 
 
This can be accomplished by clicking the 
“Admin.” button in the log in dialog and logging in 
as administrator. The default administrator 
password is “password.” 
 

Then select the desired user and click 
“Password” to assign a new one or “Delete User” 
to remove the selected user. 
 
If you choose to delete a user a warning note will 
appear to inform you that all the scenario and 
trends that the user you are deleting may have 
written will also be deleted. 
 
The administrator can be given a new password, 
but it must not be forgotten. 
 
Note: You cannot delete the administrator user. 
 

2.2 Chest Drain Manikin Enable / Disable 
When starting SimMan for the first time after installing the software on a new PC, you must tell the 
software which manikin version is connected to the PC. 
Older SimMan manikins do not have chest drain functionality and require more air to fill the bladders 
used for pneumothorax decompression simulation.  
You must specify whether or not your Manikin has chest drain functionality. This setting is stored in 
the computer. 
You can later change this setting through the “Options” menu. See 2.14.4. 
The following dialog box will then appear. Select the appropriate option. 
Selecting “With Chest Drain” causes less air to be filled into the pneumothorax bladders. This is the 
safest option if you are uncertain of the Manikin type. 
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2.3 SimMan Personal Computer User Interface 

 
 

2.4 Personal Computer User Interface Overview 
The SimMan User Interface allows you to control the SimMan Universal Patient Simulator. 
The user interface also presents status of the simulator and an event log, which can be saved or 
printed. 
 
 
The SimMan user interface is divided into sections: 
 
“Cardiac Controls” controls and indicates status 
for ECG, Blood Pressure with BP auscultation 
sound, Defibrillation and External Pacing. 
  
See 2.5 for more information on using “Cardiac 
Controls.” 
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“Airway and Auscultation Controls” controls and indicates 
status for spontaneous breathing, the airway features, 
auscultation and vocal sounds. 
 
See 2.6 for more information on using “Airway and 
Auscultation Controls.” 

 

“Monitor Controls” controls and indicates status 
for patient monitor parameters. 
 
 

 

Clicking the “more…” button opens the 
“Monitor Control” dialog for adjusting all 
parameters on the Patient Monitor. 
 
By ticking the “Link” tick box, you can 
make the Systolic and Diastolic sliders 
move together. 
 
See 2.7 for more information on 
controlling the Patient Monitor. 
 
 

“Register Events” allows you to register “ABC 
Action,” “Miscellaneous,” and “Medication” events 
that are not automatically registered on the 
simulator. 
 
See 2.9.1.5 for more information on registering 
Events and customizing Event Lists. 
The Manikin picture indicates manikin status and 
performed events including BP Auscultation, 
Pulse Check, Ventilations Performed, 
Defibrillation Performed, Pacing, Intubation, IV-
line, Suction, and Precordial Thump. 
 
See 2.8 for more information on Manikin 
Functions.  

 

The Manikin picture can be exchanged for an 

event log view by clicking on the  button 
found in the lower right corner of the screen. 
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“Event Logging” controls, found in the lower right 
corner, can be used to pause, resume and restart 
the event log.  The “!” button automatically adds 
user-entered comments directly to the log. 
 
See 2.9 for more information on the Event Log. 
 
“Scenarios” allows you to select a scenario and 
has scenario run, pause and stop controls.  
 
See 2.12 for more information on running a 
Scenario and see chapter 4 for more information 
on creating your own Scenarios. 
 
“Trends” allows you to select a trend and has 
trend run, pause and stop controls. 
 
See 2.11 for more information on running Trends 
and see chapter 2.14.2 for more information on 
creating your own Trends. 
 
The Program menu-bar in the top left corner of the screen 
controls system options. 
 
See 2.14 for more information on the SimMan Program 
Menu. 
 
Most SimMan functions can also be controlled by 
two infrared remote controls. 
 
One remote control specifically controls airway 
functions while the other controls cardiac 
functions. 
 
The remote controls may be used 
simultaneously. 
 
Several functions are common to both remotes 
allowing use of only one. 
 
The green keys on the lower row can be user 
defined with up to ten events per remote. See 
2.10.2.1 for more information on programming 
the user-definable (green) keys on the remote 
controls’ lower row. 

 
 
To disable the remote controls, deselect “Remote Enabled” in the “Options” menu. 
This will be useful if there is more than one SimMan in a room and other 
instructors are also using the remote control. 
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2.5 ECG Rhythm Selection 

2.5.1 Running Rhythm 
The Running Rhythm field shows 
the ECG currently running on the 
Patient Monitor and Manikin.  
 
At start-up, the simulator will 
always have a Sinus rhythm with 
a HR of 80. 

2.5.1.1 Editing the Running Rhythm 

See Appendix 5 for a complete list of available ECGs. 
The heartrate of the Running Rhythm can be increased or decreased by clicking on 
the HR Up/Down buttons. 
Heartrate steps and available heartrates are dependent on the basic running rhythm. 

Using the Cardiac or Airway remote control, press the HR Up/Down keys when 
no Waiting Rhythm is selected.  
When a “Waiting Rhythm” is selected, the HR for the “Running Rhythm” cannot 
be adjusted using the remote controls. 

 

To edit a new Running Rhythm, click on the “Set Running Rhythm” button to activate the 
ECG selection menu. 
You can now set the 
parameters of the ECG rhythm. 
 
See 2.5.3 for instructions on 
setting “Running and Waiting 
Rhythms.” 
 

 When using the remote control, only the Heartrate of the “Running Rhythm” can be adjusted 
directly. 

 

2.5.1.2 Artifacts 

ECG artifacts directly affect the “Running Rhythm.” 
Muscular or electrical artifacts can be selected by ticking the appropriate 
box. Ticking the box again deselects the artifact. 
 

2.5.1.3 Extrasyst. Rate (/min) 

This control shows and controls the extrasystole rate of the “Running 
Rhythm.” The frequency of extrasystoles (if selected) can be varied from 
2/min to Bigeminy (every second beat is an extrasystole) and they will 
occur randomly, at approximately the rate selected. Click on the Up/Down 
buttons to vary the rate. 
 

 With the Cardiac remote control, press ESR Up/Down keys to vary the 
Extrasystole Rate.  

2.5.1.4 Manual Extrasyst. 

Clicking the “Manual Extrasyst.” button immediately generates an extrasystole of the 
selected type. If the “Running Rhythm” does not specify extrasystoles, one Unifocal 
PVC will be generated. 
 

 With the Cardiac or Airway remote control, press the “Manual Extrasyst.” key.  
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2.5.2 Waiting Rhythm 
The “Waiting Rhythm” section allows you to have a 
new rhythm waiting for activation by user or by a 
shock. 

To move the “Waiting Rhythm” to the “Running Rhythm,” click the “Wait->Run 
Activate” button. 
The “Waiting Rhythm” now becomes the “Running Rhythm” and the “Waiting 
Rhythm” field will be empty.  
A shock on the manikin will have the same result as “Activate,” if shock is enabled. 

 With the Cardiac or Airway remote control, press the “Activate” key. 
4 

To exchange the “Waiting Rhythm” and the “Running Rhythm” click the “Wait=Run 
Paroxysmal” button. 
 
Clicking the “Wait=Run Paroxysmal” button when there is no “Waiting Rhythm” copies the 
“Running Rhythm” into the “Waiting Rhythm” field. 

 

 With the Cardiac remote control, press the “Parox.” key. 

2.5.3 Setting the Running and Waiting Rhythms 
See Appendix 5 for a complete list of available ECGs. 
To set a new “Running or Waiting Rhythm,” click on the corresponding “Set Rhythm” button, 
to activate the ECG selection menu. 

 
You can now set the 
parameters of the ECG rhythm 

 With the Cardiac or Airway remote control, press “QRS Type” or any “Basic Rhythm” key to 
activate “Set Waiting Rhythm.” 

  

2.5.3.1 QRS Type 

 
 
 
 
There are seven different 
QRS waveforms named 
“A” to “G” which can be 
selected. 
 Available QRS types 
vary with each Basic 
rhythm. 
 

 

Supraventricular QRS types for: Sinus, A-Tach, A-flutt, A-fib, 
Junctional, 1°AVB, 2°AVB types 1 and 2, 3°AVB (rate = 60), 
Atrial Pacemaker, PACs and PJCs 

A. Normal upright QRS-T. 
B. Upright QRS with ST depression and T inversion. 
C. Upright QRS with ST elevation. 
D. Bundle Branch Block. Broad R-wave with T inversion. 
E. Biphasic QRS with T inversion.  
F. QS with ST elevation. 
G. Bundle Branch Block. Broad R-wave with upright T. 
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Ventricular QRS types for: Idioventricular, V-Tach and 
PVCs. 

A. Broad rS wave. 
B. Broad R wave. 
C. Broad QS wave. 
D. Broad QS wave.  Same as C. 
E. Broad R wave.  
F. Broad Rr Wave. 
G. Broad Rr Wave. Same as F. 

 With the Cardiac remote control, press the “QRS Type” key repeatedly until the 
desired QRS type is displayed. 

2.5.3.2 Basic Rhythm 

 
Select a new basic rhythm by pulling down the “Basic Rhythm” list box and 
selecting the desired type. 
The Basic rhythm will appear with default HR and no extrasystoles. 
 

 With the Cardiac or Airway 
remote control, press any Basic 
Rhythm key. 
If V.Fib or Pacemaker rhythms 
are selected, the HR Up/Down 
keys can be used to select the 
desired type of V.Fib or 
Pacemaker rhythms. 

CARDIAC REMOTE: AIRWAY REMOTE: 

2.5.3.3 Extrasystole 

 
Select the desired extrasystole by pulling down the “Extrasyst.” list box and 
selecting the desired type. 
Available extrasystoles vary with the basic rhythm. For example, all 
extrasystole types are available with a Sinus rhythm and none are available 
with an Asystole rhythm. 
 

 With the Cardiac or Airway remote control, 
press any Extrasystole key. 
Pressing the same key again will clear the 
“Extrasyst.” selection. 

If no “Waiting Rhythm” is selected, the extrasystole 
will go directly into the “Running Rhythm.” 

Cardiac Remote: 
 

 

Airway 
Remote: 

 

2.5.3.4 Extrasystole Rate 

Select the desired extrasystole rate by clicking the “Rate (/min)” Up/Down 
buttons. 
 

 With the Cardiac remote control, press the “ESR” Up/Down keys.  
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2.5.3.5 Heartrate (HR) 

 
Select the desired heartrate by pulling down the “HR” list box and selecting the 
desired rate. 
 
Available heartrates vary with the basic rhythm. 
 

 With the Cardiac or Airway remote control, press the “HR” Up/down keys. 

2.5.3.6 Blood Pressure (BP) 

Blood pressure can be set as part of the ECG rhythm.  
The advantage is that when the BP is set as part of the ECG rhythm, 
it will change at the same time a “Waiting Rhythm” is activated.  
 
To set the blood pressure, tick the “Set BP” box and select thee 
desired blood pressure by pulling down the “BP” list box. 
 
If “Set BP” is not ticked, the BP will remain unaffected by the ECG 
selection, as long as it is a perfusing rhythm. 
 
Non-perfusing rhythms include V.fib, Asystole, Agonal, and Ventr. 
Standstill. Also a PEA/EMD condition will always set the BP to 0/0.  
 
See 2.5.6 for more information on setting Blood Pressure. 

 

 The remote controls only allow for Blood Pressure to be set 
directly. 

 

2.5.3.7 Activating the Rhythm 

After the rhythm has been edited, clicking the “OK” button will move the new 
selection into the “Running / Waiting Rhythm.” 

Clicking “Cancel” will cancel the selections made and revert to the previous 
selections. 

 With the Cardiac or Airway remote control, pressing the “Activate” key will 
move the new selection into the “Running Rhythm.” 

 With the Cardiac remote control, pressing the “Parox.” key will move the new 
selection to the “Running Rhythm,” and the previously “Running Rhythm” into 
the “Waiting Rhythm.” 

2.5.4 Defibrillation 
This button allows you to enable or disable the response to a defibrillator shock on the manikin. 
 
When enabled, a shock of 5J or more will activate the “Waiting Rhythm,” providing 
one has been selected. Clicking the button disables this function. 
 
When disabled, the simulator will not respond to a shock. Clicking the button 
enables this function. 

 With the Cardiac remote control, toggle between enable / disable using the 
“Defib. Enable” key. 

A shock is indicated with a shock symbol on the manikin picture and is registered in the event log, 
regardless of whether shock is enabled or disabled.  
Shock enable / disable does not effect a scenario shock event. 
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2.5.5 Pacing 
This button allows you to enable or disable a response to external pacing and to alter the pacing 
threshold. At start-up, “Pacing” is enabled and pacing “Threshold” defaults to 80 mA. 
 
When Pacing is enabled, SimMan will automatically detect the external 
pacer once it is producing electrical output. If the pacing spikes are being 
produced above the set Pacing Threshold level, pacing capture will be seen 
and felt if the blood pressure is adequate.  
Clicking on the Pacing Threshold Up or Down buttons alters the threshold 
level. 
 
Clicking on the “Pacing” button selects "Pacing Disabled" and external 
pacing will not result in capture, regardless of the current pacing strength. 
 

 With the Cardiac remote control, toggle between enable / disable using the 
“Pacing Enable” key. 

External Pacing is indicated with a pacing symbol on the manikin picture and is registered in the 
event log, regardless of whether pacing is enabled or disabled. 
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2.5.6 Blood Pressure (BP) 
The Blood Pressure function affects the BP shown on the patient monitor, the auscultated or palpated 
blood pressure on the manikin’s left arm and the strength of the pulses.  
 
Blood pressure can be set as part of the ECG rhythm (see 
2.5.3.6) or adjusted directly on the BP controls.  
 

To adjust both systolic and diastolic at the same time use the left up / down 
buttons. The BP will be adjusted maintaining the same pulse pressure 
between the systolic and diastolic pressures. 

 With the Cardiac or Airway remote control, press the “BP” Up / Down 
keys. 

 
To adjust systolic or diastolic pressures individually, use the up / down 
buttons to the right of the corresponding parameter. 
A difference of 10 mmHg between the systolic and diastolic pressures will 
be maintained. 
 
Ticking the “EMD/PEA” box will set BP to 0/0. 
Removing the tick will bring the BP back to its previous setting. 
 

 With the Cardiac or Airway remote control, press the “EMD/PEA” 
key. 

 
The Korotkoff sound volume in the manikin’s left arm can be adjusted by 
dragging the volume control lever. 

 
To simulate an auscultatory gap in the Korotkoff sound, tick the “Gap" 
box. 

2.5.6.1 Blood Pressure / Pulse Relationship 

The pulse strength relates to the BP setting according to the following table. 
 

Systolic 
BP 
(mmHg) 

Carotid  
Pulse 

Femoral 
Pulse 

Radial/Brachial 
Pulse 

>= 88  Normal Normal Normal 
< 88 Normal Normal Weak 
< 80 Normal Normal Absent 
< 78 Normal Weak Absent 
< 70 Weak Absent Absent 
< 60 Absent Absent Absent 

 
Blood Pressure will also influence NIBP and SPO2 measurement and the SPO2 curve on the Patient 
Monitor. 
 
When the systolic BP drops below 50 mmHg, the Patient Monitor will fail to measure NIBP and SPO2 
measurement and the SPO2 curve will flatten. 
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2.6 Airway and Auscultation Controls 
 
“Airway and Auscultation Controls” controls and indicates 
status for spontaneous breathing, difficult airway 
functions, auscultation sounds, and vocal sounds. 

2.6.1 Airway Controls 
This function allows you to set the state of all SimMan’s airway functions: 

• Trismus 
• Tongue Edema 
• Pharyngeal Obstruction 
• Decreased Cervical Range of 

Motion  
• Laryngospasm 
 

• Right Pneumothorax 
• Left Pneumothorax 
• Reduced Right Lung 

Compliance 
• Reduced Left Lung Compliance  
• Stomach Decompression 

Each function is identified with a ToolTip when the mouse is moved over 
the button. 
Each airway function has two states: 

  Not Active.  For instance, Trismus off 

  Active.  For instance, Trismus on. 
 
The  indicates clear or less trouble for the student, while the  indicates 
trouble. 
The  always indicates that a bladder inside the Manikin has been filled 
with air. 

 
 

Note: Activating Right Pneumothorax will also activate Reduced Right 
Lung Compliance and activating Left Pneumothorax will also activate 
Reduced Left Lung Compliance. 

 With the Airway remote control, press a button to 
activate the desired function(s). Press the button again 
for deactivation. 

2.6.1.1 Preset Buttons 

 will set all functions to Not Active.       

 

 With the Airway remote control, press 

. 
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Can't Intubate, Can Ventilate will 
set: 
Tongue Edema, Pharyngeal 
Obstruction, Cerv. ROM and 
Stomach Decompr.  

 
Can't Intubate, Can't Ventilate 
will additionally set Right and 
Left Lung compliance. 

 

 With the Airway remote control, press . 

 

 With the Airway remote control, press 

. 

2.6.2 Spontaneous Breathing 
Spontaneous “Breathing Rate” can be adjusted from 0 to 40 breaths per minute.  
 
To adjust the breathing rate, use the "Breathing Rate" Up / Down buttons. 
 
 

 With the Cardiac or Airway remote control, press the “BR” Up / Down 
keys. 

 
To stop spontaneous breathing, click on "Apnea". 
Breathing will also automatically stop when BP is 0/0, both right and left lung compliance is active, 
and when laryngospasm is activated. 

 With the Cardiac or Airway remote control, press the “Apnea” key. 

2.6.3 Exhale CO2 
The Manikin will exhale CO2 during spontaneous breathing or ventilation if 
"CO2 Exhaled" is ticked. 

 With the Airway remote control, toggle the “Exhale CO2” key.  

Through the Options menu, it is possible to automatically disable exhaled 
CO2 two minutes after it is enabled.  

The "Exhale CO2" control is independent of the CO2 setting in the "Monitor Controls." "Exhale CO2" 
turns the CO2   being exhaled through the manikin’s airway on or off. The amount of CO2 exhaled is 
always the same. 

2.6.4 Vocal Sounds 
Vocal sounds are generated by the computer’s sound system. For the vocal sounds to come from the 
manikin’s head, the sound out of the computer, typically the speaker or head phone output, must be 
connected to the “Audio Input” on the SimMan Link. 
 
 
To activate vocal sounds on the manikin, select the desired sound from the 
“Vocal Sounds” pull down menu. 
 
Vocal sound volume can be controlled using the lever adjacent to the “Vocal 
Sounds” selection menu. 
Note: Because the sound is generated by the computer’s sound system, 

you may also have to adjust its volume. It is activated from the  symbol 
typically found in the lower right corner of the Windows screen. Most Laptop 
computers also have a volume adjustment knob close to the sound output 
connector.  
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 With the Cardiac or Airway remote control, press the desired sound 
key. 

 
You can also assign sounds to the user-definable keys on the remote 

control. See  2.10.2.1 for more information on assigning sounds to 
the remote control. 

You can add your own vocal sounds to the vocal sound list 
by copying “.wav”  files into the SimMan installation 
“Sounds” folder. 

When the SimMan program starts, it will search for “.wav” files in this 
folder, and list their names in alphabetical order on the “Vocal Sounds” 
pull-down menu. 
 
See Appendix I for more information on the SimMan data file structure. 
 

 

2.6.5 Adding New User Defined Vocal Sounds 
You can add new vocal sounds in two steps: 

1) Record the new vocal sounds using your computers sound recorder. 
2) Save the recorded sounds in the SimMan “Sounds” folder. 
 

 
1) To record new sounds: 
 
Connect a microphone to the microphone input on 
your PC or use the built-in microphone, if your PC 
is equipped with one. 
Under the “Tools” menu, select the “Microphone 
Controls” option. It is recommended that you 
adjust the microphone input level, “Mic in,” by 
dragging the lever to the maximum level that does 
not cause sound distortion. 

From the Windows Start menu, open the application under the folder: 
Programs/Applications/Multimedia/Sound Recorder (in Win98) 
Programs/Accessories/Entertainment/Sounds Recorder (in Win2000/XP) 
 
The Sound Recorder will appear.  
Record the sound using the microphone and the “Record” and “Stop” 
keys on the Sound Recorder window. 
 
2) To save the recorded sound: 
 

On the Sound Recorder window, select “Save As” and save the recorded 
sound file under the following folder on your PC hard drive: 
 “C:\Program Files\Laerdal Medical\SimMan\Application\Sounds 
 
Note: This is the default SimMan location. If you chose to install in a different 
location during the SimMan install, the correct location on your PC will be 
relative to the location you chose. 

 
The next time the SimMan program starts, it will search for “.wav” files in 
this folder and list them in alphabetical order in the “Vocal Sounds” pull-
down menu. 
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2.6.6 Speaking Via a Microphone through the Manikin 
Some PCs have the ability to directly output 
microphone input through the speakers and 
headset output. This may be cumbersome to set up 
and the volume gain may be lower than when you 
record and play sounds. 
 
The “Microphone Controls” dialog enables an 
easier way to use a microphone to speak directly 
through the Manikin’s head speaker, than by using 
the standard Windows Mixer. It also provides more 
amplification of the microphone sound. 
 
Under the “Tools” menu, select the “Microphone 
Controls” option. Enable microphone input by 
ticking the “Activate Mic Monitoring” tick box. 
 
“Mic In” and “Master Out” levels can be adjusted. 
“Master Out” controls the output level of all PC 
sounds. 
 
The downside of this function is that it introduces a 
small delay in sound output. This delay can be 
adjusted, but if it is set too short, the sound will be 
distorted. Ticking the “Use DirectSound” tick box 
will, on some PCs, allow for shorter delays. Try to 
adjust to the shortest delay your PC can handle. 
 
  

2.6.7 Auscultation Sounds 
At start up, all auscultation sound will be "Normal." 
 
To choose a different sound, select the 
desired sound in the corresponding list box. 
 
The list boxes are identified with ToolTips 
when the mouse is moved over them.  

Lungs: Heart: 

 

Bowel: 

Lung sounds will, by default, be the same for both lungs and is selected through 
the Right Lung list box. The Left Lung list box will be gray (disabled) and cannot 
be used. 
However, the volume of each lung is controlled separately. 
There are two options for lung auscultation sounds.  

1. Having the same sound in both lungs. 
2. Having a different sound in each lung. 

 
In the first case, the left lung sound selection menu is disabled. 
 
Using the “Option” menu, you can select or deselect “Dual Breath Sounds.”  
Note that the sound levels are always separate for each lung. 

 Auscultation sounds cannot be selected from the remote controls. 
 
  

2.6.7.1 Auscultation Sound Volumes 

At start up, all Auscultation Sound Volumes will be set to medium. 
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To adjust a sound’s volume, drag the 
corresponding slide control to the desired 
level.  
The slide controls are identified with 
ToolTips when the mouse is moved over 
them. 

 

 

 With the Airway remote control, right and left lung volumes can be 
adjusted by pressing the “RL Vol.” and “LL Vol.” Up / Down keys  

2.6.8 Heart and Lung Animation 
During spontaneous breathing or forced ventilations, air in the lungs is indicated 
on the user interface. It is not an accurate indication of the amount of air in the 
lungs, but a non-quantified indication. 
 
The heart animates every heartbeat. 

Heart and Lung Animation can be turned on / off individually in the "Options" 
menu by selecting or deselecting “Heart Animation” or “Lung Animation. 

2.7 Monitor Controls 

2.7.1 Basic Parameter Control 
 
“Monitor Controls” controls and indicates status 
for CO2, SpO2 and Temperature. These 
parameters are only shown on the Patient Monitor 
and do not affect any functions on the Manikin. 
 
To adjust CO2, use the "CO2" Up / Down buttons. 
 

 With the Cardiac or Airway remote control, press the “CO2” Up / Down 
keys. 

 
CO2 scale can be set to mmHg or kPa in the "Options" menu by selecting or 
deselecting “CO2 in mmHG.” 
To adjust SpO2, use the "SpO2" Up / Down buttons. 
 

 With the Cardiac or Airway remote control, press the “SpO2” Up / Down 
keys. 

 
 
To adjust Temperature, use the “Temp.” Up / Down buttons. 

 Temperature cannot be adjusted with the remote controls. 
 

Temperature scale can be set to Celsius or Fahrenheit in the "Options" menu by 
selecting or deselecting “Temp in Fahrenheit”. 
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2.7.2 Monitor Parameter Control Dialog 
 
Clicking the “more…” button next to 
the temperature control opens the 
“Monitor Control” dialog. 
 
The “Monitor Control” dialog controls 
all parameters shown on the Patient 
Monitor. 
 
Note: Ticking the “Link” tick box, 
makes the Systolic and Diastolic 
sliders move together. 
 
The sliders are only suitable for course 
adjustments. Click on arrows for fine 
adjustment, or use the mouse scroll 
wheel while hovering the mouse 
cursor above the control. 
  

2.7.3 Patient Monitor Control 
The parameters of the Patient Monitor can be turned on and off individually from 
the “Patient Monitor” menu. The idea is that the instructor can add new 
parameters as they become available. 
 
Selecting “Select All” or “Remove All” turns on or off all parameters. 
 
“TOF” indicates the number of responses. “TOF %” indicates the ratio in strength 
between the first and fourth response. If the “TOF” is less the 4, then this ratio is 
0. 
 
 “Cycle NIBP now” starts a NIBP measurement on the Patient Monitor. This allows 
the instructor to guide the students back on the right track, if desired. 
 
See chapter 6 for more information on the SimMan Patient Monitor. 
 
You can also turn off or set the QRS “Beeper 
volume” from this menu. 

 

 
 

 

2.7.4 Parameter Variability 
For enhanced realism, selecting “Monitor Parameter Variability” on the Options 
menu enables variability of some values shown on the Patient Monitor.  
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2.8 Manikin Functions 
The Manikin picture indicates manikin status and 
shows performance of specified events. 

 

 
Pulse Check 
This symbol is placed on the manikin at 
the location a check for pulse is being 
palpated and can be carotid, femoral, 
brachial or radial. 

 
Chest Compressions 
Performed 

 
Ventilations Performed 

Defibrillation Performed 
(detects shocks above 5 
joules) 

Precordial Thump Pacing (detects external 
pacing) 

Blood Pressure Auscultation / Palpation 
The symbol, the bar and the “Calibrate BP” button appear when 
pressure is building up in the cuff. 
 
The blue bar indicates the cuff-pressure. 
The green lines indicate the set diastolic and systolic pressures. 
 
Clicking the “Calibrate BP” button, allows you to calibrate the 
blue bar indicator to your measurement instrument. When the 
new window appears, inflate the cuff until the measurement 
instrument shows 100mmHg and then press the “Calibrate” 
button. The blue bar is now calibrated to 100mmHg. 
 
The “Calibrate BP” dialog can also be started from the “Tools” 
menu by selecting “Calibrate BP…” from the menu list. 
 
In addition, some manual registrations can be indicated on the manikin picture: 
  
Intubation  
 

Oxygen 

 
 
 
IV line 

 

 

 
Suction 
(automatically removed after 5-
10 sec.) 

 

 

2.9 Event Log 
The Manikin picture can be exchanged for an 

Event Log view by clicking on the  button 
found in the lower right corner of the screen. 
 
Every new operator setting and every action on 
the manikin is entered into the Event Log. 

 
 

  



 

6895 rev F  Laerdal Medical 2002 page 46 of 125 

2.9.1 Event Log Controls  
The Event Log time indication defaults to zero when the SimMan program is started. 
 
Elapsed time from the start of the session is displayed. This 
elapsed time is also displayed in the upper left corner of the 
Patient Monitor.  
 
Clicking the "Pause Event Log" button pauses the Event Log and stops the elapsed 
time.  
 

 

 
Clicking the "Restart Log" button clears the Event Log and the time resets to zero. 
"Restart" will also remove indicated events such as Intubation and IV-Line from the 
manikin picture. You must answer “Yes” in a confirmation dialog before the log will 
restart. 
 
Note: “Restart Log” is different from “Reset Patient” on the “Tools” menu. “Reset Patient” 
will restore SimMan and the Manikin picture to its original setting at start up. 

 

2.9.1.1 Adding Comments to the Event Log 

The instructor can add additional comments to the log by clicking the 
“!” button. 
An “Enter Comment” dialog will appear. Enter the 
comments you want to appear in the log and click 
the “Submit” button. 
 
Uncheck the “Close on Submit” box if you don’t 
want this window to automatically close when you 
click “Submit”. 

 

2.9.1.2 Saving the Event Log 

 
To save the current event log to disk, select “Save Log” from the “File” menu. 
The “Save As” dialog will be displayed. 

 

 
 
The save dialog allows you to enter student name(s) and comments prior to saving the 
file. 
 
Type in filename and click “Save” to save the log. 
 
The file is saved in XML format. See Appendix IV for more information on the XML Event 
Log Format and its usage. 
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2.9.1.3 Saving the Trend History when Saving the Event Log 

 
It is possible to save pictures of all trend view windows along with the log file. Depending 
on which style template you choose when printing the log, these pictures may be shown in 
the log. From the Options menu, select “Save trends images when saving the log.” A 
Trend View dialog will appear immediately after saving the log. 
 

 

 
This dialog has a new button “Save Images” rather than the usual “Close” button. 
There is also a “Save Image” check-box for each trend that let you select which trend 
images to save. 
 
Adjust the time scrollbar and window’s width so that the desired period of the trend history 
is displayed. Then click the “Save Images” button. 
 
In the …\SimMan\Application\Report\Als folder, a folder will be created with the same 
name as the saved report but with “_images” at the end. This folder will contain one 
picture for each of the trends displayed at the time you clicked the “Save Images” button. 
 
When printing the saved report, these pictures will be copied to the same temporary folder 
(not a subfolder) the generated .html file is copied to. It is then possible to create a style 
template that also displays these curves. See appendix IV for more information. 

 

  

2.9.1.4 Printing the Saved Log 

 
Select the “Print Saved Log…” from the file menu to print a previously saved log. 
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Select the log you want to print, choose a style template 
and click on “Open.”  
 
A preview will be displayed in your default Internet browser. 
Select to print from the browser. 
 
See Appendix IV for more information regarding XML. 

2.9.1.5 Print Current Log 

 
Select “Print Current Log…” to print the event log that is shown in the event log window. 
 
Notice that this printout does not contain the additional info fields you enter when you 
save the log. 
 

 

Select the Style Template and press OK. 
 
A preview will be displayed in your default Internet browser. 
Print the log from there. 

2.10 Manual Logging of Events 

2.10.1 Entering Events / Handling Event Lists 
 
Events that are not 
automatically registered by the 
manikin can be entered using 
the three event lists. 
    

 The Cardiac and Airway remote control bottom 
rows give 10 different events for each remote 
control. 
 
The upper events work with the shift button 
pressed, the lower without the shift button pressed. 
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Pull down the list of events in the desired 

category by clicking the  button. Select 
the desired event. 
 
The event is entered in the log when it is 
selected.  
 
The events can be organized in folders. 
Click on the “+” sign to expand the folder 
and view the events saved in that folder. 

 
Normally the list closes when an event is 
selected, but it can be “pinned.” Clicking on 
the “pin” symbol at the bottom of the list will 
cause it to stay open. Click the symbol 
again to “unpin” the list. 
The list can also be “undocked” from the 
main SimMan window into its own window 
by right-clicking the list and selecting 
“Undock.” This window can then be moved 
freely over the screen. 
 
 

The list is now in its own window with a title 
bar. Click on the title bar to drag the list 
anywhere on the screen. 
 
You can also resize it by clicking the 
mouse in the window’s lower right corner 
and dragging it to the desired size before 
releasing the mouse button. 
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In Windows 2000/XP, you can also make 
the list window transparent by right-clicking 
it and selecting “Transparent.” 
 
To dock the list back into the SimMan 
window again, right-click it and select 
“Dock.” 
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2.10.2 Edit Registered Events List 

 
 
Using the “Edit” 
button, new events 
can be added, 
deleted, or assigned 
from the event logging 
lists. 
 
This function also 
allows you to assign 
events to remote 
control keys. 

 
Right clicking on the title of the event list you want to edit gives you 
the Edit menu. 

Add Folder 
ADDS A NEW FOLDER IN THE SELECTED LIST. 

Add Event Adds a new event to the selected list. 
Hide Hides the event under the cursor. 

Hidden events are shown in the example on the right.  
Hidden events are not shown in the lists on the main 
SimMan window. 

Unhide Unhides the event under the cursor, if it is hidden. 
Delete Deletes the event under the cursor. 
Rename Renames the event under the cursor. You can also rename an event by clicking 

to select it and then clicking on it again to type the new name. 
Sort 
Alphabetically 

Sorts the selected event list alphabetically. 

  
It is possible to copy events to and from folders. Open the folder and use the mouse to 
drag and drop events into it. To move an event rather than copying it, hold down the 
shift button while dragging the event to the desired location. 

 

The folder named “System Events” contains all events that originally came with the 
system. This folder is hidden and undeletable and it is not possible to edit its content. If 
you have deleted an original event from an event list and want it back, you can copy it 
from this folder. 

 

  
Make sure to click the “OK” button to save your changes.  
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2.10.2.1 Assigning Events or Sounds to the Remote Control 

You can assign events or sounds to the lower row of keys (green) on each remote. Two events can 
be assigned to each key, one with the shift key pressed simultaneously and one without the shift key 
pressed. 
 

 
The two key rows are shown on the “Edit” menu screen. 

 
An event or sound is assigned to a remote control key by 
dragging the event / sound from the list to the desired key 
identifier. 
 
Releasing the event / sound on or below the key assigns it to 
the key directly. 
 

 

Releasing the event / sound above the key assigns it to the 
shift function of the key. 
 

 

 
To remove an assignment from a remote control key, click 
and drag the assignment from the remote control to the 
recycle bin. This event will still appear on the event list. 

 

 

   
Make sure to click the “OK” button on the screen to save your changes.  
 

2.10.2.2 Using Events while Running Scenarios or Event Handlers 

When starting a Scenario or an Event Handler two things can happen 
to the event menus: 

1. If the Scenario or Event Handler has customized event menus 
stored with it, the event menus in the GUI will change to these 
menus when the Scenario or Handler starts. See 4.6 for more 
info. 

2. If the Scenario or Handler does not have customized event 
menus, a new folder in the event menu is created called 
“Current Scenario Events.” This folder contains all events used 
in the Scenario or Handler. 

 
In both of these cases, all events used in the Scenario or Event 
Handler will be visible when they are started, even if the events are not 
defined in event menus prior to starting. 
 
If you start a Scenario and the Scenario starts an Event Handler, the 
events of the Event Handler will be added to the menus. 
 
See 2.12 for more information about running Scenarios and 2.13 for 
information about running Event Handlers. 

 

  
 

2.11 Trends 
Trends allow CO2, SpO2, Temperature, Blood Pressure, Heartrate, Breathing Rate, Cardiac Output, 
and Central Venous Pressure to develop over a time period according to a preprogrammed trend. 
 
Several Trends can be preprogrammed. 
 
Trends are relative. Trend parameters will always begin from the system’s current settings and all 
changes made by the Trend are relative to those settings. 
 
See chapter 3 for more information on working with Trends. 
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2.11.1 Main Window Trend Controls 
“Trends” controls can be used to start, stop and pause trends.  
The Trends list box shows available trends. Trends 
can be organized in folders. 
 
 “All Active Trends” must be selected to perform an 
action on all running trends. 
 
The “Active Trends” folder contains a list of currently 
running trends. 
 
The rest of the items are either Trends or folders 
containing Trends. 

To start a trend, select the desired trend and click the 
"Start Trend" button. 
 
 
When a trend is running, the text “Trend Running” will 
display with its current time position. 
 
The running Trend also appears in the “Active Trends” 
folder. 
 
When selected, it will show its current time position. 

Selecting “All Active Trends” changes the Trend time 
position to current log time. 

 
To stop the trend, select it in the “Active Trends” folder 
and click the "Stop Trend" button. 
 

 
To pause the trend, select it in the “Active Trends” 
folder and click the "Pause Trend" button. 
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To resume the trend, select it in the “Active Trends” 
folder click the "Start Trend" button. 

To run another trend simultaneously, select it from the 
list and click the “Start Trend” button. The title will now 
change to “Multiple Trends Running.” 
 
Note: When the title says “Multiple Trends Running,” 
the stop, pause and resume controls affect all running 
trends. 
 
To control an individual trend, you must first select it 
from the “Active Trends” folder. 
 

2.11.2 Trend View 
For a graphical view of the Trends, click the "View" button. 

 
In addition to many other controls, the “View Trend” window also contains start, stop and pause 
controls. 
 
When “All Active Trends” is selected, the time reflects the log time and all values are absolute. The 
moving cursor describes the now time. 
 
Values to the left of the cursor are the history. All changes are recorded. 
 
To the right of the cursor are the projected values, i.e. the contribution of all active trends added 
together. 
 
Making manual changes to the values will cause the projected trend to shift up or down. 
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This is a list of the “Active Trends” running in the 
above view.  
 
Note: It is possible to have multiple instances of 
the same Trend running simultaneously. 
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When an individual “Active Trend” is selected, the displayed time will switched to reflect how long the 
Trend has been running. 
 
The values are now shown in relative mode. For example, the trend starts at 0 and the view shows 
how much the trend has affected the values and how much it will affect them. 
 

“Representation” allows you to select the 
desired value mode. “Absolute Values” mode 
reflects the actual values. “Relative Values” 
mode reflects the relative changes from the start 
of the trend. See above. 
“Infusion/noninfusion” allows you to specify 
whether or not the trend is an infusion trend. 
Ordinary trends automatically stop when they 
reach their end. An infusion trend does not stop, 
it continues until stopped manually or by a 
scenario, and then returns to its relative starting 
point. 
 
See 3.4.3 for more information on Infusion 
Trends. 
 
The “Time Scrollbar” at the bottom allows you to 
scroll within the display window. 

“Session duration” allows you to set the 
maximum value of the “Scroll Bar.” “Session 
Duration” is automatically increased as needed. 
“Windows width” allows you to set display 
window width. 
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Dragging the scrollbar to the right brings the last two trend curves into view. 

 

Clicking the “Printer” symbol prints the trend 
curves view. 

Right clicking any of the trend windows allows 
you to save the window as a picture for future 
review. 
 
Select the desired picture format and a standard 
save dialog will appear. The pictures are by 
default stored in the same folder as the log files. 
That is the ..\SimMan\Application\Report\Als 
folder. 
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2.11.3 Trend Max/Min Value Control 
Prevent the parameter values from changing 
beyond the desired range, by selecting “Trend 
Max/Min Values…” in the “Options” menu to open 
the “Set Max/Min Trend Values” dialog. 

 

2.12 Running Scenarios 

THE SCENARIO IS A MEANS OF PREPROGRAMMING CERTAIN AUTOMATIC 
RESPONSES FROM THE MANIKIN. SCENARIOS ARE PROGRAMMED TO SET 
THE MANIKIN IN A CERTAIN CONDITION WITH AUTOMATIC CHANGES TO 
CONDITION BASED ON STUDENT ACTION, OR THE LACK THERE OF. 
 

A SCENARIO CAN BE STARTED BY SELECTING “START SCENARIO…” FROM 
THE “FILE” MENU. 
 
The “Start Scenario…” dialog allows you to select a scenario and read its comments. 
If someone send you a new scenario or you download it from the web, it may contain new trends, 
handlers or sounds. When you run or edit the scenario, all trends, handlers and sounds used by the 
scenario will be copied to the logged-in users profile. But only if a trend, handler or sound with the 
same name doesn’t already exist. If it already exists, the existing one will be used instead. 
 
See chapter 4 for more information on building scenarios using the “Scenario Editor.” 
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A SCENARIO CAN ALSO BE STARTED 
DIRECTLY FROM THE SCENARIO 
CONTROLS BY SELECTING THE DESIRED 
SCENARIO AND CLICKING THE “RUN 
SCENARIO” BUTTON.  
When a scenario is running, the text “Scenario Running” 
will display.  

“Frame number” with “Frame time” and “Patient time” 
are displayed to the right of the scenario controls. 
When a scenario is running, Event Log controls are disabled 
but may be controlled by the Scenario controls.  
 
Note: Stopping / pausing / resuming a scenario controls affect 
all running trends. However, trends can be controlled without 
affecting scenario execution. 
All controls are available when a scenario is running, and can be used to override the values set by 
the current scenario frame.  
Note: If the scenario changes frame, it may again override your manual selections. The scenario may 
also start trends that could cause the values to change. 
To pause a running scenario, click the “Pause Scenario” 
button.  

While the scenario is paused, it will not accept manually 
input events. Running trends and event logging are also 
paused and the text “Scenario Paused” will be blinking. 
To terminate a scenario, click “Stop Scenario” button. 
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2.13 Running an Event Handler 

THERE ARE THREE TYPES OF EVENT HANDLERS, ONE FOR EACH TYPE OF 
EVENT CATEGORIES: ABC, MISCELLANEOUS, AND MEDICATIONS. 
 
An Event handler is programmed to perform a specified action each time a specified event occurs. 
The programmer selects the events to handle and the desired action. 
 
A running Event Handler is common to a running Scenario. Both respond to events and both can 
perform actions. However, the Scenario can respond to some Events in additional to those the 
Handlers can respond to. Also, the Scenario can change its response to an event, a Handler always 
responds in the same way. 
 
The Handlers are easier to understand and to build on your own. 
 
See chapter 5 for more information on building Event Handlers using the “Handler Editor.” 
 

EVENT HANDLERS ARE STARTED BY SELECTING “START ABC 
HANDLER…”, “START MISC. HANDLER…”, OR “START MEDIC. HANDLER…” 
FROM THE “FILE” MENU. 
 
The “Open” dialog allows you to select a Handler and read its comments. 
 

A hand icon appears next to its category name in the “Register Events” control to indicate a Running 
Handler. 
 
Moving the cursor over the hand displays a ToolTip describing the Running Handler. 
 

 

CLICKING ON THE HAND ICON CAUSES 
THE “STOP MEDICATION HANDLER” 
PROMPT TO DISPLAY. 
 
Clicking the prompt stops the Handler. 



 

6895 rev F  Laerdal Medical 2002 page 61 of 125 

ONLY ONE HANDLER FROM EACH 
CATEGORY CAN BE RUNNING 
SIMULTANEOUSLY. 

A HAND ICON IS DISPLAYED NEXT TO 
EACH EVENT CATEGORY HAVING A 
RUNNING HANDLER . 
 

2.14 Program Menu 
The “Program” menu is, in some cases, an 
alternative way of performing some actions. In 
other cases, it is the only way. 
 

2.14.1 File Menu 
The “File” menu controls system wide commands. 
 

Start Scenario Start Scenario is an alternative way of 
starting a scenario. See 2.12. 

Start ABC Handler Starts an ABC Event Handler. See 2.13. 

Start Misc. Handler Starts a Miscellaneous Event Handler. See 
2.13. 

Start Medic. Handler Starts a Medication Event Handler. See 2.13. 

Save Log Saves the Event Log. See 2.9.1.2. 

Print Log Prints the Event Log. See 2.9.1.4. 

Log in as another 
user… 

Allows a different SimMan user to log in. See 
2.1.2. 

Exit Closes the program. Clicking the “X” in the 
upper right corner of the SimMan window 
also closes the program. 

 

2.14.2 Edit Menu 
The “Edit” menu controls edit commands. 
 

Edit Scenario  

Edit ABC Handler  

Edit Misc. Handler  

Edit Medic. Handler  

Edit Trends  

 

2.14.3 Patient Monitor Menu 
The “Patient Monitor” menu controls, as the 
name implies, the Patient Monitor. See 2.7.3. 
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2.14.4 Options Menu 
The “Options’ menu controls various settings. Check the 
references for more information on each control setting. 
 
Dual Breath Sounds See 2.6.7. 

Heart Animation See 2.6.8. 

Lung Animation See 2.6.8. 

Temp in Fahrenheit See 2.7.1. 

CO2 in mmHg See 2.7.1. 

Remote Enabled See 2.4.  

Exhaled CO2 2 min. 
Auto Off 

See 2.6.3 

Monitor Parameter 
Variability 

See 2.7.4 

Save trend images 
when saving log 

See 2.9.1.3. 

Chest Drain… See 2.2. 

Trend Max/Min values See 2.11.3. 

 

2.14.5 Tools Menu 
The “Tools” menu controls various commands.  
 

Mic Monitor… Opens the microphone monitor dialog for 
improving direct microphone volume. This 
control can also set the Windows volume 
control. See 2.6.6. 

Calibrate BP… Allow you to calibrate the SimMan SW to 
your cuff pressure meter. See 2.8. 

Calibrate Patient 
Monitor 

Opens the calibrate dialog on the Patient 
Monitor. Follow the on screen instructions to 
complete the calibration. 

Reset Patient Restores the SimMan and Manikin picture to 
its original setting at start up. 

 

 

2.14.6 Help Menu 
The “Help” menu provides access to SimMan Help and displays 
software version information in the about dialog. 
 
Show Help Opens SimMan Help window. 

About SimMan Shows SimMan SW version info. See 
Appendix II for more information on other 
programs that make up the SimMan 
software. 
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3 Edit Trends 
  
 

TO EDIT A NEW OR EXISTING TREND, SELECT “EDIT TRENDS” FROM THE 
“EDIT” MENU. SEE 2.14.2. 
 
“Edit Trends” allows you to create, edit, print and save Trends. 
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Use the scrollbar on the right to bring the remaining two trend curves into view. 
 

 

3.1   Load Trend 
 
To load an existing trend, click the “Load 

Trend” button  for the “Open” 
dialog, select the desired Trend and click 
“Open.” 
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3.2   Save Trend 
 
To save a trend, click the “Save Trend” 

button  for the “Save As” dialog, 
type in a new file name or select an 
existing Trend name and click “Save.” 
 
Note: Selecting an existing Trend name 
from the “Trends” folder when saving, will 
overwrite the selected Trend. 

 
  

3.3   New Trend 
 

The “New Trend”   button loads a 
default (flat line) trend for editing. 
 
 
 

3.4 Editing Trends 

3.4.1 Basic Editing 
Each trend curve has five points that can be moved up / down and 
left / right to create a curve. 
 
The starting point is zero and cannot be moved. 
 
Trends are relative by default and will always use current system 
values when the trend is started. 
 
 
 
  
 
 
To edit a trend curve, click and drag a point to the desired position. 
 
When the cursor moves over a point, it will change to a cross hair 

. 

As you drag a point, its position is shown in the lower left corner of the “Edit 
Trends” window as “Time in minutes”/”Relative value” 
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By default, only the systolic 
pressure can be edited in the 
blood pressure trend. 
 
The trend will maintain the start 
value difference between 
systolic and diastolic pressures. 
 
Systolic and diastolic pressures 
can be edited individually by 
ticking the “Edit Diastolic” tick 
box. 
 

3.4.2 Absolute / Relative Mode 
There are two modes of “Representation,” 
including “Absolute Values” and “Relative 
Values.” 
 
Here, “Relative” means that the trend begins 
at the system’s current value when you start 
the trend. This is relatively 0 and the trend 
either increases or decreases this value. 
 
“Absolute” displays a view of what the trend 
would look like with the current. Trends are 
stored relatively rather than absolutely. 
 
Trends may be viewed in absolute values, 
taking the current starting values as the zero-
value and showing them on an absolute scale. 
 
 

 
 
In both “Relative” and “Absolute” views, the cursor can be dragged 
across a trend curve. Cursors on all the other curves will follow the 
dragged cursor. 
 
The number in the lower left corner of each trend curve displays the 
time at the cursor position. 
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3.4.3 Infusion Trends 
There is a special type of trend for infusions. 
 
An ordinary trend stops by itself when it reaches 
the last point. Infusion trends do not stop by 
themselves. Once they reach the last point, they 
will not make any more changes until they are 
stopped manually or by a Scenario or Event 
Handler, see 2.11. 
 
When an infusion trend stops it will normalize its 
current value back to the original value in the 
specified number of seconds. 
 
The infusion trend on the right will cause the 
heartrate to increase by 25 BPM within 10 
minutes. When the trend is later stopped, the 
heart rate will drop by 25 BPM within 2 minutes. 
This occurs independently of other changes made 
to the heartrate. 
 

3.4.4 Trend Length 
You can set the width of the “Trend Window.” The 
last point, except for in an “Infusion Trend,” 
determines the actual Trend length. 
 
 
 
   

3.4.5 Trend Max/Min Limits 
Since the starting point is not known when making a trend, the trend can cause values to exceed a 
desired level. To prevent this from happening, set the “Trend Max/Min Values” from the “Options” 
menu. See 2.11.3. 

 

3.5 Print Trends 

To print a trend, click the “print trend” button . 
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4 Scenario Builder 
This is a graphical editing tool that allows you to create, edit and save scenarios to be run under 
the "Run Scenario" function. See 2.12 for more information on running scenarios. 
 
Note: Be aware that the “Scenario Builder” and “Run Scenario” function can be running 
simultaneously. This is useful when creating and testing of scenarios. 
 

 
 

4.1 Startup 
 The Scenario Builder is started by selecting “Edit 
Scenario” from SimMan’s main program “Edit” menu. 

 

4.2 Program Menu 
 The “Program” menu is located on the upper left corner 
of the “Scenario Builder” window.  

 

4.2.1 File Menu 
The “File” menu controls Windows system commands. 
 

New Window Opens a new scenario builder window. Good 
for copying frames from one scenario to 
another. 

New Scenario Clears the view and displays a new scenario 
containing only Frame0 with its initial values. 

Load Scenario Loads an existing scenario. 

Save Scenario Saves a scenario. 

Print Scenario Prints a scenario. 
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Exit Exits the Scenario Builder.  

 

4.2.2 Edit Menu 
The “Edit” menu contains copy and paste controls. 

Copy Copies the selected item(s) to the clipboard. 

Paste Pastes the copied items from the clipboard. 
Select All Selects all items. 
Edit Event Menus Customizes the Event Menu for this scenario. 

It is also possible to assign specific events to 
the remote control keys. See 4.6 for more 
info on customizing event menus. 

 

4.2.3 View Menu 
 The “View” menu contains one item that opens a dialog 
listing the “Used Events and Trends. 

 
Below is an example from a simple scenario. 
 

 
 

4.2.4 Help Menu 
The “Help” menu provides access to SimMan Scenario Builder Help and 
displays software version information in the “About” dialog. 
 
Show Help Opens the Help window for SimMan Scenario 

Builder. 
About SimMan Shows software version info in the “About” 

dialog. 
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4.3 Load Scenario 

The  button allows you to load and edit an existing Scenario. The “Open” dialog allows you 
to select a Scenario and read its comments. Once the desired Scenario is selected, click “OK.” 
 
 
This function can be activated from the “File” menu as well. 
 
If someone send you a new scenario or you download it from the web, it may contain new 
trends, handlers or sounds. When you run or edit the scenario, all trends, handlers and sounds 
used by the scenario will be copied to the logged-in users profile. But only if a trend, handler or 
sound with the same name doesn’t already exist. If it already exists, the existing one will be 
used instead. 

 

4.4   Save Scenario 
 

The  button allows you to save a Scenario to your “Scenarios” folder. 
 
The function can also be activated from the “File” menu. 
 
The comment field allows you to enter descriptive text about the scenario to be read in the 
“Open” dialog when a Scenario is opened for editing or execution.  
 
Note the “Save Menus” check box. This box is checked by default. When checked, the 
scenario’s “Event Menus” will be saved along with the scenario. You can edit how the menus will 
look by clicking the “Edit Menus…” button. See 4.6 for more information about event menu 
customization. 
 
All trends, handlers and sounds that are used in the scenario are saved in the scenario file. If 
you want to send the scenario to someone else, the scenario file is the only file you need to 
send. 
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4.5 Print Scenario 
To print a Scenario, select "Print Scenario" from the “File” menu.  
 
 
Select preferred print mode in the "Select Print 
Mode" dialog and click "OK." 
 
"Reduced size" prints the scenario on one A4 / 
Letter page. 
 
"Full size" prints the scenario on two A4 / Letter 
pages. 
 
You can include the comments with the printout by 
ticking / unticking the “Print Comments” tick box. 
The comments will be printed on a separate page. 
 
 

 

 

If you are printing the scenario “Full size” on two 
pages, you can use the page break preview line in 
the drawing area to see where the page break will 
naturally occur. 
 
If the break splits a frame, you can drag the line to 
force appropriate page breaks. 
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4.6 Customize Event Menus 
When creating a scenario, you can customize how the event menus will look for a user 
running the scenario to ensure that the menus are organized and easy to operate. 
 

 

Selecting “Edit Event Menus” from the “Edit” menu displays this dialog. This function 
also allows you to assign events to remote control keys. 
 
The functionality is almost identical to the edit menus in the GUI. See 0. The difference 
is that by default, the events used by the scenario  are visible and the non-used are 
hidden. You must unhide non-used events if you want them to be seen when running 
the scenario. 

 

 
When saving the scenario the customized event menus is by default included in the scenario file 
and these menus will be shown when running the scenario (instead of the logged-in users 
menus). If you un-check the “Save Menus” tick-box the menus will NOT be saved with the 
scenario and the logged-in users menus will be shown when running the scenario. 

 
The edit menus dialog can also be opened by clicking the “Edit Menus…” button in the save 
dialog. 
 
If a running scenario starts a handler, the events used in that handler will be appended to the 
corresponding event menu. 
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4.7 Actions / Events Terminology 
 
It is important to understand the difference between Events and Actions, especially in the 
“Scenario Builder.” 
 
Events 
Things that happen outside the control of a scenario and usually caused by student(s) are called 
“Events.” The ABC / Miscellaneous / Medication Events in the main SimMan window are also 
Scenario Events. There are also time “Events” caused by either of the two timers reaching a 
predetermined limit. 
 
Actions 
In a scenario, Actions are performed by the scenario. For example, changing a parameter value, 
creating an airway complication and making vocal sounds are Actions performed by scenarios. 
 
See 4.16 for more information on Events. 
See 4.15 for more information on Actions. 
 

4.8 Frames 
A “Frame” represents a state in the scenario. 
  
The frame’s large upper field, the “Actions field,” 
contains the name of the frame “Frame0” and 
state descriptions. 
 
Frame0 is always the starting frame, and will 
always contain a default setup when “New 

Scenario”  is selected. 
 
“Frame0” cannot be deleted, but can be changed. 
 

 

 
The scenario is constructed from a set of frames. Each frame represents a state of the patient. 
The Scenario can only operate in a single frame at any given time. The scenario moves to other 
frames as events specified in the “Events fields” occur. 
 
The “Event fields” are found along the bottom of 
each frame. They specify events that will cause 
the scenario to advance. 
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To control which frame the scenario moves to, connection lines are drawn from each event box 
to the desired frame. When the specified event occurs, the scenario moves to the corresponding 
frame. 
 

 
The scenario always starts in “Frame0.” The “Action field” sets the initial parameters when 
starting a scenario. When the scenario moves to another frame, the new frame’s “Action field” 
changes the parameters as specified. All other parameters are not changed. 
 
The actions in the “Action field” are performed one time when the Scenario enters a new frame. 
While in a frame, the instructor can change any of its values. 
 
When the Scenario is running, the frame name 
and time and Patient time are displayed next to 
the control buttons. 

 

 

 

4.9 Creating a Frame 
To create a frame, click the "Create Frame" button and then on the screen in the 
location desired. 
The frame automatically receives a name that displays in the “Action field.” 
 
After the button is clicked, the cursor changes, as shown to the right, and then changes 
back again after the new frame is placed in the scenario.  
Note: Frame names do not indicate any order of execution. They are reference names 
for programming purposes only. 

 

 

4.10 Moving Frames 
To move a frame, click the “Select Frame” button. 
  
Click on the border of the frame you want to move and 
drag it to the desired location before releasing the 
mouse button. 
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You can select several frames by holding down the “CTRL” key while clicking the border of 
additional frames or using the cursor to click and drag a frame around the desired frames.  

 
Once the selected frames are marked with a blue border, you can click on one and drag them 
around. 
 

 
  
 

4.11 Copying Frames 
A frame must be selected before you can copy it. 
 
First click on the “Select” button. 

 

To select one frame, click its border. To select several 
frames, hold down the “CTRL” key while clicking the 
border of additional frames. 

Or, click and drag a frame around the frames you want to copy. 
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The selected frames are marked with a blue border. 
 

 
To copy the selected frames, select “Copy” from the 
“Edit” menu and then select “Paste.” See 4.2.2. (You 
can also use standard Windows hotkeys CTRL+C for 
copy, and CTRL+V for paste.) 

 

The copied cells are pasted at the top left of the drawing 
area and are selected and ready to be moved to the 
desired location. 

 

You can also open a new “Scenario Builder” window and 
use the copy and paste functions to copy frames from 
one Scenario to another. 

 

 

4.12 Resizing Frames 
Click and drag the frame’s right edge to resize the 
frame, including “Event fields,” horizontally. 
 
 

 
Click and drag the frame’s bottom edge to resize 
the frame, but not the “Event fields,” vertically.  

 
Click and drag the frame’s lower right corner to 
vertically and horizontally resize the frames 
simultaneously. 
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4.13 Connecting Frames 
 
Frame connections are 
drawn from an “Event field” 
in one frame to the “Action 
field” of another frame. When 
an event occurs, they specify 
the frame to which the 
Scenario moves. 
 
You can have only one 
connection from each “Event 
field,” but multiple 
connections to a frame. The 
connection line arrows show 
the direction of the 
connection.  
 
 
 
Non-empty “Event fields” not 
connected to a frame will 
shade red. Empty “Event 
fields” having connections 
will also shade red.  
 
If a frame has no input 
connector, the “Action field” 
will shade red. 

 
 

 
 
To connect frames, click the "Connect Frames" button.  

Frames can now be connected in three different ways. 
 
1. Connection with a line. 
 
Click the “Event field” you want to connect and drag the mouse to the “Action field” for 
connection before releasing the mouse button. 
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2. Connecting through a node. 
 
Connecting through a node is useful when connecting backwards in a Scenario because 
connection lines going back and forth can make the scenario hard to read. 

 
 
To connect through a node: 

- Click in the “Event field” you want to connect. 
- Drag the mouse outside the frame and release the 

mouse button to open the “Connect to Frame” 
dialog. 

- From the dialog, select the desired connection frame 
and click “OK.” 

 

 

3. Connecting back to the current frame. 
 
Connecting back to the current frame saves repetition of 
frames. 
This one-frame scenario will make the manikin moan at 
start up and again every time a shock is given. 
 

Connection though a node and using the special loop back symbol are two ways for connecting 
a frame back to itself. 
To connect using the loop back symbol: 

- Click in the “Event field” you want to connect. 
- Drag the mouse to the “Action Field” of the same frame and release the mouse button. 

 

The cursor will change shape when in “connection mode.” 
 

 
To change the cursor back to normal, click the “Select” button. 

 
    

4.14 Deleting Frames, Connections and Frame Items 
To delete a frame, click the “Select frame” button.  
Note: “Select frame” is usually the default mode when no other function is selected. 
Select the frame by clicking its border (the 
selected frame is marked with a blue border) and 

then clicking the “Delete Item” button . The 
frame and its connections will be deleted. 

You can also delete a group of frames by 
selecting them using the cursor to drag a frame 
around them. 

 

 
“Frame0” cannot be deleted from any scenario. 
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To remove a connection, select it by clicking it (the 
connection line will become blue when selected) 

and then clicking the "Delete Item" button .  

 
 
To remove an “Action” or “Event,” select the item 
by clicking on it (the item will be highlighted in 
blue) and then clicking the "Delete Item" button 

. 

 

 
  
  

4.14.1 Undoing Last Deletion 

The last performed deletions can be undone using the  button. 

If undo is not possible, the button will be disabled.  
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4.15 Actions 
These are the Actions the Scenario performs when a new frame is entered. They are located in the 
“Action fields” of a frame and are performed once each time the running scenario enters a frame. 
 
To add or edit Actions in a frame: 
 

 

 

Click on the 
desired Action 
button 

Click the “Action 
field” in the frame you 
want to edit 

Edit the dialog and click “OK.” The programmed 
action will now 
appear in the 
frame’s “Action 
field.” 

 
Available Actions: 

4.15.1   ECG 

       
 
The “ECG Action” button allows you to set the ECG and ECG related parameters. If "Extrasyst." 
is blank (default), “Extrasyst. Rate (/min)” will not change from its previous state. 
 
Note: EMD / PEA can be set from this Action. Selecting EMD/PEA will set the blood pressure to 
zero independent of the ECG rhythm and the blood pressure setting. Selecting “No EMD/PEA” 
will bring the blood pressure to the previous setting, if the ECG is a perfusing rhythm. 
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4.15.2  Blood Pressure 

    
 
The “BP Action” button allows you to set blood pressure (“Systolic” and “Diastolic” pressures can 
be set independently) and Korotkoff sound volume. 
  
 
If the volume set lever is not moved, the sound volume will be unaffected and 
indicated by “…” to the lower right of the lever. 

 
 

If the volume is changed, the volume level will display as “0” to “10.” 
 

 
 

Tick the “Gap” tick box to make an auscultation gap in the Korotkoff sound. 
 
 
 

 

4.15.3 Set Trend Max/Min  
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The “SimMan Trends Action” button allows you to set parameter limits for vital 
signs.  
Default limits are specified in the SimMan main program “Options” menu by 
selecting “Trend Max/Min Values…”. These limits are overridden when set in a 
Scenario. It is good practice to set the limits in scenarios to ensure they are set 
correctly. 
 

 

Only the limits with the “Change” tick box ticked will be set, the others remain 
unchanged. 

 

 

4.15.4 Clear Shock Count 
In the “Defibrillation Performed” event, you can set the event for execution after a certain 
number of shocks. The number of shocks is accumulative throughout the scenario. For instance, 
"3 Shocks" means three shocks given from “Frame0” or from the frame where the shock counter 
was reset. The function "Clear Shock Count" can be used to set the shock counter to zero in any 
frame. 
 

 
The “Clear Shock Count” action goes directly into the 
frame without setting any dialog. 

 
 
Example: 
The following scenario will convert the patient after 
three shocks. The patient will then re-fibrillate after 30 
seconds and can be converted again after three 
shocks… and so on. 
 
If there had been no "Shock count=0" in “Frame0,” the 
scenario would have worked the first time, but when the 
patient re-fibrillated (return to “Frame0”), the scenario 
shock-counter already has three shocks so it would 
have gone directly to “Frame1” again. 

4.15.5  Pacing Enable - Ignore 

  
 
 
Pacing Enable. Enables Pacing capture and allows you to set a Pacing threshold. 
 
Pacing Ignored. Disables Pacing Capture. The “Pacing Capture Started” and “Pacing with 
Capture” events cannot occur if “Pacing Ignored” is set. 
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4.15.6 Comments 

                        
The “Comments Action” button allows the addition of user-entered comments 
in the Event Log to aid in evaluation of student performance. 

 

 

4.15.7 Auscultation Sounds 

 
The “Auscultation Sounds” button allows 
you to select Right Lung, Left Lung, Heart 
and Bowel sounds in addition to setting 
sound volume. 
Note: Right and Left Lung sounds are set 
independently. 
 
If “No Change” is selected, the 
corresponding sound is unaffected. 
 
If the volume set levers are not 
moved, the volume will be 
unaffected and indicated by “…” 
to lower right of the lever.  
 
If the volume is changed, the 
level will be displayed as “0” to 
“10.” 
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4.15.8  Airway 

 
The “Airway Action” button allows you to set the state 
of all SimMan airway functions. 
 
Each function is identified with 
a ToolTip when the mouse is 
moved over the button. 

 

 

Each airway function has three states: 

  No change. The function will remain as  
       set in previous frames. 
 

  Not Active. The function will be cleared.  
       For instance, Trismus off. 
 

  Active. This function will be activated. 
       For instance, Trismus on. 
   

 

4.15.8.1 Preset Buttons 

 
 

 sets all functions to Not Active.        

 
 

 

  
Can't Intubate, Can Ventilate sets: 
Tongue Edema, Pharyngeal Obstruction, Decreased 
Cerv. ROM and Stomach Decompr. 

 
 

 
Can't Intubate, Can't Ventilate additionally sets Right 
and Left Lung Compliance. 

 

 

4.15.9 Vocal Sounds 

 
The “Vocal Sounds Action” button 
allows you to select one of the 
manikin vocal sounds. 
 
The sound can be repeated several 
times at the selected interval. 
 
Repetitions of sounds will continue, 
even if the scenario changes frame. 
Repeated sounds can be stopped in 
another frame by selecting “Stop 
Sound.” 
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Starting another sound in another 
frame overrides a previously 
programmed sound. However, the 
sound will not start until the one 
playing has completed. 
 
 
 
 

4.15.10 Breathing Rate 

 
The “Breathing Rate Action” 
button can be set from 0 - 40 
breaths per minute in increments 
of two. 
 
Output of CO2 in the exhaled air is 
also controlled from this function. 
  

 

4.15.11 Vital Signs (Patient Monitor) 

 
 
The “Vital Signs Action” 
button allows you to set 
Patient Monitor 
parameters. 
 
Only the parameters with 
the “Change” tick box 
ticked will be changed, 
the others remain 
unchanged. 
 
 
CO2 and Temperature 
scales are controlled by 
the SimMan settings. 
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4.15.12 Trends 

 
The “Trends Action” button allows you to start and stop a Trend from a Scenario. 
 
 

 

 
There are two options for starting a trend. 
 

1. “Start Trend” starts the selected trend to run 
simultaneously with all other trends that may 
be running when the scenario enters this 
frame. 

2. “Start This Trend, Stop All Others” starts the 
selected trend to run while stopping all 
others when the scenario enters this frame. 

 
There are two options for stopping a trend as well. 

1. Selecting “Stop Trend” stops a specific 
Trend. 

2. Selecting  “Stop all Trends” stops all active 
Trends. 

 

 
Clicking the “Edit…” button opens the “Trend Editor.” 

 

 
“Trend Editor” allows you to specify the Start Time 
and Duration of a Trend. 
 
Start Time defines how far into the programmed 
trend the trend will be started. For example, this 
Trend will skip to the start position and start from 
there. 
 
Duration defines how long the trend will run.  
 
The default is that the trend starts from the 
beginning and continues until its last defined point, 
except for infusion trends that continue until they are 
stopped. 
 
Trends cannot be started and stopped in the same 
frame. 
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Note: It is only possible to have one action of each 
type in a frame. To overcome this limitation, you can 
use two frames and have the scenario automatically 
progress to the next frame immediately. See 4.16.12 
for more information on Time Events. 

 

4.15.13  Patient Time 

     
 

The “Patient time Action” button allows you to manipulate the “Patient time.” “Patient time” is a 
time parameter counted down in every frame of a scenario. It will count down and stop at zero. 
You can use the value of the “Patient time” as an Event to move to another frame. See 4.16 for 
more information on using Events. 
 
This scenario action can be used to set a “Patient time” value, add a value to “Patient time,” or 
to subtract a value from “Patient time.” The default value is 0, so it must be set to a value greater 
than zero to be of any use. 
 
 
When running a Scenario, “Patient time” is 
displayed below the Frame number / time next to 
the control buttons. 
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Example: In this example, 
the “Patient time” is set to 
90 seconds in Frame0. If 
no CPR is given, the 
patient will go from V.fibr. 
to Asystole in 90 
seconds. If CPR is 
started, the patient is 
given 15 more seconds, 
and for every 10 seconds 
of CPR given, the patient 
is given back 15 seconds 
in “Patient time.” 

 
 

4.15.14 Add Medication Handler 

     
 

The “Medication Handler Action” button allows you to start or stop a “Medication Handler.” Only 
one “Medication Handler” can be active at one time. If you start a new “Medication Handler” 
while another one is active, the running “Handler” will automatically be stopped before the new 
one is started. 
 
See chapter 5 for more information on “Event Handlers.” 
 
Clicking the “Edit…” button starts the “Medication Handler” editor. 
 

 

 

4.15.15 Add ABC Handler 

     
 

The “ABC Handler Action” button allows you to start or stop an “ABC Handler.” Only one “ABC 
Handler” can be active at one time. If you start a new “ABC Handler” while another one is active, 
the running “Handler” will automatically be stopped before the new one is started. 
 
See chapter 5 for more information on “Event Handlers.” 
 
Clicking the “Edit…” button starts the “ABC Handler” editor.  
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4.15.16 Add Miscellaneous Handler 

              
 

The “Miscellaneous Handler Action” button allows you to start or stop a “Miscellaneous 
Handler.” Only one “Miscellaneous Handler” can be active at one time. If you start a new 
“Miscellaneous Handler” while another one is active, the running “Handler” will automatically be 
stopped before the new one is started. 
 
See chapter 5 for more information on “Event Handlers.” 
 
Clicking the “Edit…” button to starts the “Miscellaneous Handler” editor. 
 

 

 

4.16 Events 
 
A running scenario detects events caused by student(s) and internal events, such as “Time 
Events.” You may specify events the scenario will check for by placing them in a frame’s “Event 
fields.” When the running scenario reaches that frame and the event occurs, the scenario will 
move to the frame connected to that “event field.” 
 
 
 
With exception of "Intubation" and "IV-Line," all 
events must happen in the frame where the events 
are specified. “Intubation” and “IV-Line” are 
remembered events, meaning they are active until 
their opposing events, “Extubation” and “IV-Line 
removed,” occur.  
 
Example 1: In this example, “Pulse checked” will 
move the scenario from Frame0 to Frame1. The 
pulse must be checked again in Frame1 to bring the 
scenario back to Frame0. Frame1 has no memory 
of the fact that the “Pulse checked” event also 
happened in Frame0. 
Example 2: In this example, performing either 
“Intubation” or “IV-Line Insertion” in Frame0 will 
move the scenario to Frame2 because “Intubation” 
and “IV-Line” events are remembered. 
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4.16.1 Adding or Editing Events in a Frame 

 

 

 

Click the 
desired 
Event 
button. 

Click the “Event 
field” in the frame you 
want to edit 

Edit the dialog and click “OK.”  
Note: Some events do not have a 
dialog. 

The programmed 
event will now 
appear in the 
frame’s "Event 
field." 

 

4.16.2 Add / Delete “Event Fields” 
In some cases, more than three event fields are needed. 
Click the right mouse button in any event field and. select 
“Add Event Output” from the menu. 

 
A new empty “Event field” is added to the right of the 
existing fields.  

 
To delete an “Event field,” click the right mouse button in 
the field you want to delete and. select “Delete Event 
Output” from the menu. 

 
Note: It is not possible to have less than three event 
fields in a frame, but there is no limit to how many may be 
added. 
 
You can resize an event field by resizing the frame. 

 

 

4.16.3 Add “Event Comment” 
“Add Event Comment” allows you to add a comment in a 
log when the student performs an action or another event 
occurs, e.g. a time event. 

 



 

6895 rev F  Laerdal Medical 2002 page 91 of 125 

 
The comment can be earmarked if the action was a 
correct or wrong step or that the comment is not 
applicable to the action. When going through the log 
during debriefing, this can aid finding interesting log 
items. 
 

 

An event frame containing a comment is 
marked with a “!” button. Click on this 
button to edit the comment. 

 
 
Available Events: 

4.16.4  Pulse Checked 

 
The “Pulse Checked Event” occurs when pulse is 
checked on the manikin. This event has no dialog 
and is displayed immediately in the “Event field.” 
 

 

It does not matter where the pulse is checked; any pulse check (Carotid, Radial, Brachial or 
Femoral) on the manikin will fulfill the criteria for the event. 
 
 

4.16.5  CPR Performed 
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The “CPR Performed Event” function allows you to set one of the following CPR related events. 
 
Started: 
• Ventilations started 
• Compressions started 
• CPR started. Either compressions or ventilations are started on the manikin. 
 
Stopped: 
• Ventilations stopped. No ventilations detected for five seconds. 
• Compressions started. No compressions detected for five seconds. 
• CPR stopped. No ventilations or compressions detected for five seconds. 
 
Performed: 
• Ventilations / Compressions / CPR performed.  

To set the amount of time allowed between the starting and stopping of a specified activity, 
click the Up / Down buttons for “Performed (accumulated) for” until the desired number of 
seconds is reached. If the activity is started and stopped several times within the same 
frame, the time of the sequences are accumulated. 

 

4.16.6  Precordial Thump 

 
The “Precordial Thump Event” occurs when a 
Precordial thump is performed on the manikin. This 
event has no dialog and is displayed immediately in 
the “Event field.” 

 

  

4.16.7  Defibrillation Performed 

   
The “Defibrillation Performed Event” allows you to 
set the event for execution when a certain number of 
shocks are given. Set “Shocks Delivered” by clicking 
on the Up /  Down buttons and then click “OK.” 
  
The number of shocks is accumulative over the 
Scenario. For example, "3 Shocks" means three 
shocks given from Frame0, where the Scenario 
started, or from the Frame where the shock counter 
was reset. Use the "Clear Shock Count" function to 
reset the shock counter in any Frame. 
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In the following example, it will take two shocks to convert the patient if performed within the first 
45 seconds. If not, it will take three shocks within an additional 30 seconds, otherwise the 
Manikin will convert to asystole. Notice that one shock could be given within the first 45 seconds 
(Frame0) and the remaining 2 shocks could be given in the next 30 seconds (Frame2). 
 

 
 
 

4.16.8  Pacing Performed 

    
 
The “Pacing Performed Event” button allows you to set one of the following Pacing related 
events. 
 
• Pacing started. Pacing is performed on the manikin. Capture may not necessarily occur. 
 
• Pacing capture started. Pacing is performed on the manikin with a current level over the set 

threshold. This event cannot happen if pacing is disabled. See 4.15.5 for more information 
on the “Pacing Enable - Ignore” Action. 

 
• Pacing capture stopped. Pacing capture has occurred and has now stopped. 
 
• Pacing with capture (accumulated) for. Pacing has been performed for more than the period 

of time you have set in this frame. If pacing is started and stopped several times within the 
same Frame, the time of the pacing sequences is accumulated. 
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4.16.9  ABC Action 

    
The “ABC Event” button allows you to set any of the ABC actions. Actions added by the “Edit” 
menu function can be programmed as events.  
 
"Intubation" and "IV-Line" differ from the other events in that they do not have to occur in the 
same Frame that the event is specified. The scenario will remember that “Intubation” has 
occurred and the event will be true in any frame after the occurrence until “Extubation” occurs. 
The same will be true for "IV-Line" which will be remembered until “IV-Line Removed” occurs. 
 
Example: In this somewhat complicated scenario, we have a limited time to give the patient 
Epinephrine and get to Frame6. To give Epinephrine, we must have either an IV-Line or an ET-
tube. While preparing Intubation or IV-line, time can be bought by performing CPR. If no CPR is 
given, the time will elapse and the patient will die (Frame4). 
 
To do all this, we will need more than three events in some frames. The test for“IV-Line” and 
“Intubation” is done in Frame5 and Frame2, while the actual registration of the event can be 
done in Frame1. 
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4.16.10  Miscellaneous 

     
The “Miscellaneous Event” button allows you to set any of the “Miscellaneous” actions. Actions 
added by the “Edit” menu function can be programmed as events.  
 

4.16.11  Medication 

      
The “Medication Event” button allows any of the “Medications,” including medications added by 
the “Edit” menu function, to be programmed as Events.  
 

4.16.12  Time Events 
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The “Time Event” button allows you to set events based on either "Patient time" or frame time 
(time in the current frame). After selecting “Patient time <=” or “Time in this Frame =,” set the 
desired time by clicking the Up / Down buttons to the desired seconds and click “OK.” 
 
Patient Time. The Patient time is equal to or less than the set number of seconds. 
 
Time in this Frame. The amount of elapsed time since the scenario entered this frame is equal 
to the set number of seconds. 
 
The scenarios have two timers. 

1. Patient timer. This timer counts downwards. It starts at zero when the scenario starts, so 
it must be set to a value before use. In addition to setting a specific value, time can also 
be added or subtracted by the scenario. See 4.15.13 for more information on “Patient 
time.” You are free to use this timer as you choose. The “Patient timer” can be used to 
count the seconds a critically ill patient has left to live. Actions performed correctly by 
the students can add to the timer. Time will be subtracted if actions performed by the 
student are dangerously wrong or if they bring the patient out of the critical state 
altogether. The scenario can be programmed to make the patient beyond rescue if the 
student does not perform the correct action and the timer will reaches zero. 

2. Frame timer (Time in this frame). This timer counts upwards from zero when the running 
scenario changes from one frame to another. This timer is intended to automatically 
change to another frame when the running scenario has stayed within the same frame 
for the specified amount of time. The running scenario cannot change the frame timer 
other than by entering a new frame. A scenario is allowed to go from one frame back to 
itself and the frame time will then be reset to zero. 
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5 Event Handlers 

5.1 Overview 
The purpose of  “Event Handlers” is to simplify automatic responses to events. Events are those 
listed in the SimMan window as ABC Action, Miscellaneous and Medication events. There is one 
Handler for each category. 
 
Scenarios can perform the same task as Event Handlers, but Event Handlers specialize in 
handling events. By running the event handlers simultaneously with a running a scenario, you 
can take event handling out of the scenario and let the scenario concentrate on the training. The 
simplified scenario is easier to build and maintain. 
 
If a scenario handles an 
event, such as starting 
a trend when a 
medication is given, it 
must go to a new frame, 
start the trend and then 
come back again. 

 
However, the event 
might happen in another 
frame causing it to 
perform the same check 
in every frame. 
 
If you also want to 
check for several other 
events, the scenario 
soon becomes long and 
cumbersome. 
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The event handlers are 
specialized in handling 
events. They jump to 
another frame, perform 
an action and jump 
back again. Since they 
run simultaneously with 
the scenario, it works as 
if the scenario were 
performing a check in 
every frame. 
 
This is how the scenario 
looks when using a 
medication handler. 
 
The scenario starts the 
medication handler. 
Once started, the 
medication handler will 
start “Trend1” each time 
“Epinephrine” is given, 
no matter which frame 
the scenario is in. 
 
The “Medication 
Handler” can be 
expanded to handle 
many drugs. 
 
In addition, you can 
start handlers that 
handle ABC and 
Miscellaneous Events.  

Medication handler: MedicHandler1 

 

 

5.2 Startup 
The Event Handler Editor is started from the “Edit” menu of SimMan’s main program. Select the 
type of handler you will edit/create. 
 
Then either start the handler to run from within a scenario (see 2.13), or you can start it to run 
stand alone by selecting “Start Handler” from the “File” menu of SimMan’s main program. 
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5.3 Handler layout 
Layout of a Medication handler. 
 

 
 

The handlers look very much like scenarios, but there are some obvious differences. There are 
differences between the various handler types as well. The most obvious differences are that 
the frames look different and that the handlers do not have connection lines between the 
frames. 
 
Each frame handles an event, a medication event 
in the Medication Handler. You select the event at 
the top of the frame. 
 
The actions are about the same as for scenarios, 
except that you can’t start handlers. 
 
There are no event fields at the bottom of the 
frames. 

 
 

Handlers work differently than scenarios. They wait until an event occurs and then check for any 
frames having that selected event. If so, it jumps to that frame and performs its actions before 
going into wait again. 
 
If you think in terms of scenarios, the scenario below is equivalent to the above handler. 

 



 

6895 rev F  Laerdal Medical 2002 page 100 of 125

A scenario 
equivalent to a drug 
handler. 
 
It is always waiting in 
frame0 for a 
selected event to 
happen. Then it 
moves to the 
corresponding 
frame, performs the 
actions and 
immediately moves 
back to frame0 
again. 
A list of all used events can be found on the lower 
left side of the handler. 
 
Unpredicted results may occur if you select the 
same event in several frames. 

 
 

5.4 Program Menu 
 The “Program” menu is located at the top left corner of 
the Handler window.  

 

5.4.1 File Menu 
The “File” menu controls Windows system commands. 
 

New Window Opens a new handler window. Good for 
copying frames from one handler to another. 

New Handler Clears the current view. 

Load Handler Loads an existing handler. 

Save Handler Saves a handler. 

Print Handler Prints a handler. 

Exit Exits the Handler Editor. 

 

5.4.2 Edit Menu 
The “Edit” menu contains copy and paste functions. 

Copy Copies the selected item(s) to the clipboard. 

Paste Pastes the copied from the clipboard. 
Select All Selects all items. 
Edit Event Menus Customizes the Event Menu for this scenario. 

It is also possible to assign specific events to 
remote control keys. See 4.6 for more 
information on customizing event menus. 
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5.4.3 View Menu 
 The “View” menu contains one item that opens a dialog 
listing used Events and Trends. 

 
Here is an example from a simple Handler. 
 

 
 

5.4.4 Help Menu 
The “Help” menu allows access to the SimMan Handler Editor Help and 
displays software version information in the about dialog. 
 
Show Help Opens the SimMan Handler Editor Help 

window. 
About Shows software version info in the dialog. 

 

5.5 Load Handler 

The  button allows you to load and edit an existing handler. 
 
The function can also be activated from the “File” menu. 
Once you select a handler, its comments are displayed in the window on the right. 
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5.6   Save Handler 
 

The  button allows you to save a Handler to your “Handler” folder. 
 
The function can also be activated from the “File” menu. 
 
Descriptive text about the handler can be entered in the comment field. This text can be read in 
the open dialog when a handler is opened for editing or execution.  
 
Note the “Save Menus” check box. This box is checked by default. When checked the “Event 
Menus” of the event handler will be saved along with the handler. You can edit how the menus 
will look by clicking the “Edit Menus…” button. See 5.8 for more info about event menu 
customization. 

 

 

5.7 Print Handler 
To print a Handler, select "Print Handler" from the “File” menu.  
 
 
Select desired print mode in the "Select Print 
Mode" dialog and click "OK." 
 
"Reduced size," prints the Handler on one A4 / 
Letter page. 
 
"Full size" prints the Handler on two A4 / Letter 
pages. 
 
You can include the comments with the printout by 
ticking/unticking the “Print Comments” tick box. 

 

 

 

5.8 Customize Event Menus 
When creating an event handler, you can customize how the event menus will look for 
a user running the handler to ensure that the menus are organized and easy to 
operate. 
 
 

 

Selecting “Edit Event Menus” from the “Edit” menu displays this dialog. This function 
also allows you to assign events to remote control keys. 
 
The functionality is almost identical to the edit menus in the GUI. See 0. The difference 
is that by default, the events used by the scenario are visible and the non-used are 
hidden. You must unhide non-used events if you want them to be seen when running 
the event handler. 
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When saving the handler the customized event menus is by default included in the handler file 
and these menus will be shown when running the handler (instead of the logged-in users 
menus). If you un-check the “Save Menus” tick-box the menus will NOT be saved with the 
handler and the logged-in users menus will be shown when running the handler. 

 
The edit menus dialog can also be opened by clicking the “Edit Menus…” button in the save 
dialog. 
 
If a scenario is running when the handler is started, the menu saved with the handler will not be 
shown. Instead the events used in the handler will be automatically appended to the 
corresponding menu already loaded by the scenario. Thus all events used by either scenario or 
handler will be visible in the menu. 
 

5.9 Frames 
A frame in the Event Handler handles an event. 
Select the event to be handled from the pull-down 
menu at the top of the frame and add the actions 
in the “Actions field.” 
 
Note: Unlike scenarios, frames aren’t numbered. 
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5.10 Creating a Frame 
To create a frame, click the "Create Frame" button and then on the screen where you 
want to place the frame. 
 
After the “Create Frame” button is clicked, the cursor changes, as shown to the right, 
and changes back again after the new frame is placed in the handler.  
 

5.11 Moving Frames 
To move a frame, click on the "Select Frame" button. 
  
Click the border of the frame you want to move and drag 
it to the desired position releasing the mouse button. 
 

 
You can select several frames by holding down the “CTRL” key while clicking the border of the 
additional frames or by clicking and dragging a frame around the frames you want to move. 
 

 
When the selected frames are marked with a blue border, you can click on one of them and drag 
both around. 
 

5.12 Copying Frames 
A frame must be selected before you can copy it. 
 
First, click the "Select" button. 

 

To select one frame, click on its border. To select 
several frames, hold down the “CTRL” key while clicking 
the border of the additional frames. You can also use 
the cursor to click and drag a frame around the frames 
you want to move. 
 
The selected frames will be marked with a blue border. 
 

 

To copy the selected frames, select “Copy” from the 
“Edit” menu and then select “Paste.” (You can also use 
the standard Windows hotkeys CTRL+C for copy, and 
CTRL+V for paste.) 

 

The copied frames are pasted in the top left of the 
drawing area and are already selected for moving to the 
desired location. 

 

You can also open a new Handler Editor window and 
use copy and paste to copy frames from one handler to 
another. 
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5.13 Resizing frames 
Click and drag on the frame’s right edge to resize 
the frame horizontally. 

 

 
    

5.14 Deleting Frames or Frame Items 
To delete a frame, click the “Select” button and select the whole frame by clicking its 
border (the border will be highlighted in blue). Or, select the item you wish to delete 
(selected items are highlighted in blue). 
 
Note: “Select frame” is usually the default mode when no other function is selected. 
 

Click on the "Delete Item" button  and the 
selected item(s) will be deleted 

 
 

5.14.1 Undoing Last Deletion 

The last performed deletions can be undone using the  button. 

If undo is not possible, the button will be disabled.  
 

 

5.15 Select an Event 
Pull down the event menu. 

 
 

Select the event you want the frame to 
handle and click “OK.” 
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5.16 Actions 
Actions are what you want the Handler to do when the handled event happens. 
 
To add or edit actions in a frame: 
 

 

 
 

Click on the 
desired Action 
button. 

Click the “Action 
field” of the frame you 
want to edit. 

Edit the dialog that appears, and 
click “OK.” 

The programmed 
action will now 
appear in the 
frame’s “Action 
field.”  

 
Available Actions: 

5.16.1   ECG 

       
 
The “ECG Action” button allows you to set the ECG and related parameters. 
If the "Extrasyst. Rate" is set to blank (default), “Extrasystole Rate” will not be changed from its 
previous state. 
 
Note: EMD / PEA can be set from this Action. Selecting EMD / PEA will set the blood pressure 
to zero independently of the ECG rhythm and the blood pressure setting. Selecting “No 
EMD/PEA” will bring the blood pressure to the previous setting, if the ECG is a perfusing rhythm. 
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5.16.2  Blood Pressure 

    
 
The “BP Action” button allows you to set blood pressure, Systolic and Diastolic rates 
independently, and Korotkoff sound volume.  
 
If the volume set lever is not moved, sound volume is unaffected and indicated 
by “…” to the lower right of the lever. 

 
 

If the volume is changed, the level will be displayed as “0” to “10.” 
 

 
 

Tick the “Gap” tick box to make an auscultation gap in the Korotkoff sound. 

 

5.16.3 Auscultation Sounds 

 
The “Auscultation Sounds Action” button 
allows you to select Right Lung, Left Lung, 
Heart and Bowel sounds in addition to 
sound volume. 
Note:  Right and Left Lung sounds are set 
independently. 
 
If “No change” is selected, the 
corresponding sound is unaffected. 
 
If the volume set levers are not 
moved, sound volume will be 
unaffected and indicated by “…” 
to the lower right of the lever.  
 
If the volume is changed, level 
will be displayed as “0” to “10.” 
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5.16.4  Airway 

 
The “Airway Action” button allows you to set the state 
of all SimMan airway functions. 
 
Each function is identified with 
a ToolTip when the mouse is 
moved over the button. 

 

 

Each airway function has three states: 

  No change. The function will remain as  
       set in previous frames. 
 

  Not Active. The function will be cleared.  
       For instance, Trismus off. 
 

  Active. This function will be set. 
       For instance, Trismus on. 
   

 

5.16.4.1 Preset Buttons 

 
 

 sets all functions to Not Active.        

 
 

 

  
Can't Intubate, Can Ventilate will set: 
Tongue Edema, Pharyngeal Obstruction, Cerv. ROM 
and Stomach Decompr. 

 
 

 
Can't Intubate, Can't Ventilate will additionally set 
Right and Left Lung compliance. 

 

 

5.16.5 Vocal Sounds 

 
The “Vocal Sounds Action” button 
allows you to select one of the 
manikin vocal sounds. 
 
The sound can be repeated several 
times at a selected interval. 
 
Repetitions of sounds will continue, 
even if the scenario changes frame. 
Repeated sounds can be stopped in 
another frame by selecting “Stop 
Sound.” 
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Starting another sound in another 
frame overrides a previously 
programmed sound. However, the 
sound will not start until the one 
playing has completed. 
 

5.16.6 Breathing Rate 

 
The “Breathing Rate Action” 
button can be set from 0 - 40 
breaths per minute in increments 
of two. 
 
Output of CO2 in the exhaled air is 
also controlled from this function. 
  

 

5.16.7 Vital Signs (Patient Monitor) 

 
 
The “Vital Signs Action” 
button allows you to set 
Patient Monitor 
parameters. 
 
Only the parameters with 
the “Change” tick box 
ticked will be changed, 
the others remain 
unchanged. 
 
 
CO2 and Temperature 
scales are controlled by 
the SimMan settings. 
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5.16.8 Trends 

 
The “Trends Action” button allows Trends to be started and stopped from a Handler. 
 
 

 

 
There are two options for starting a trend. 
 

1. “Start Trend” starts the selected trend to run 
simultaneously with all other trends that may 
be running when the handler enters this 
frame. 

2. “Start This Trend, Stop All Others” starts the 
selected trend to run while stopping all 
others when the handler enters this frame. 

 
There are two options for stopping a trend as well. 

1. Selecting “Stop Trend” stops a specific 
Trend. 

2. Selecting “Stop all Trends” stops all active 
Trends. 

 

 
Click the “Edit…” button to open the Trend Editor. 

 

 
“Trend Editor” allows you to specify the Start Time 
and Duration of a Trend. 
 
Start Time defines how far into the programmed 
trend the trend will be started. For example, this 
Trend will skip to the start position and start from 
there. 
 
Duration defines how long the trend will run.  
 
The default is that a trend starts from the beginning 
and continues until its last defined point, except for 
infusion trends that last until they are stopped. 
 
Trends cannot be started and stopped in the same 
frame. 
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5.16.9  Comments 

                        
The “Comments Action” button allows the addition of user-entered comments 
in the Event Log to aid in evaluation of student performance. 

 

 

5.16.10 Set Trend Max/Min  

                
The “SimMan Trends Action” button allows you to set parameter limits for vital 
signs.  
 
Default limits are specified in the SimMan main program “Options” menu by 
selecting “Trend Max/Min Values…”. These limits are overridden when set in a 
Scenario. It is good practice to set the limits in scenarios to ensure they are set 
correctly. 
 

 

Only the limits with the “Change” tick box ticked will be set, the others remain 
unchanged. 
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6 SimMan Patient Monitor 

6.1 Introduction 
The SimMan Patient Monitor emulates an ordinary patient monitor. It is used to display vital 
signs parameters and waveforms for the student. It is controlled by the instructor using the PC, 
but will allow alarms to be set along with some customization using its touch sensitive screen.  
 
This chapter focuses on use of the touch screen for setting alarms and performing other 
customization. See 2.7 for more information on using the PC to control the Patient Monitor. 

 



 

6895 rev F  Laerdal Medical 2002 page 113 of 125 

 
As mentioned above, the screen is touch sensitive. It is split into several fields and two buttons. 
When a field is touched, a menu appears. A picture representing of the layout of the fields is 
shown below. There are two types of fields, waveform fields and number fields. The waveform 
fields are the upper ones to the left. The rest are number fields. Note that one number field is 
much wider at the bottom. Its layout is specialized to contain the NIBP numbers; besides its 
layout it is an ordinary number field. 
 
The two buttons are the “Setup” button that opens the “Setup Menu” and the “Alarm Disable” 
button that switches off a sounding alarm. 
 

 

6.2 Setup 
The “Setup Menu” is displayed when the “Setup” button 
is pressed. 
 
Selecting “(No change)” closes the menu. 

 
Selecting “Disable alarm sounds” disables alarm sounds and the 
green bell in the lower left corner changes to red and is overwritten 
with a line. 

 
Selecting “Set time to re-engage alarms” allows you to set the 
amount of time an alarm will remain disabled when an alarm sounds 
and the “Alarm disable” button is pressed. The default is two 
minutes. 

 

Selecting “Set beeper volume” allows you to set the volume for the 
ECG/SPO2 beeper to High, Medium or Low or to turn it off. 
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Selecting “Save setup” allows you to save up to five setups. 
Configure the monitor as wanted and then select “Save Setup” from 
the menu. You can then select the setup under which you want the 
configuration stored. 

 
Selecting “Restore setup” restores any of the saved setups.  
Selecting “Reset to default” resets the configuration to the default.  
Selecting “Help” displays basic help.  
Selecting “Calibrate Touch Screen” allows you to calibrate the screen 
since there may be some difference in the location you touch the 
screen and the location the monitor reads. Choosing this menu starts 
the calibration. Follow the on-screen instructions:  

1. Press “Calibrate”. 
2. Touch the two points as requested. 
3. Press “OK” to finish the calibration. 
4. Press “OK” again on the message that notifies you that the 

new calibration data is stored in the Patient Monitor registry. 
 
The calibration can also be started from the “Patient Monitor” menu 
in SimMan’s main program. 

 

 

6.3 Waveform Fields 

6.3.1 Modifying a Waveform 
When touching a waveform, you will be given a menu. 
For example, this menu will display for the ECG 
waveform. 
 
Selecting “(No change)” closes the menu. 

 
Selecting “Change sweep rate” allows you to choose a sweep rate of 
either 12.5 mm/s or 25.0 mm/s. These values are only approximate. 

 
Selecting “Change color” allows you to change the color of the 
waveform. 
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Selecting “Change function” allows you to display another waveform 
or clear the current waveform field. 
 
Note: If you select to display a waveform already displayed in 
another waveform field, the waveform will be moved and its previous 
position cleared. 

 
Selecting “Clear” will clear the current waveform field.  
 

6.3.2 Selecting a New Waveform for an Empty Waveform Field 
If no waveform is selected for the waveform field touched, the menu 
for selecting a new waveform appears. 
 
Note: This is different from no displayed waveform. A waveform field 
may have a selected waveform and still not display a waveform if the 
instructor has not enabled the waveform. 

 
 

6.4 Number Fields 

6.4.1 Modifying a Number 
This menu appears when you touch a number field that 
already contains a number. In this case the HR. 
 
Selecting “(No change)” closes the menu. 

 
Selecting “Change upper limit” allows you to change the upper alarm 
limit. 

 

Selecting “Change lower limit” allows you to change the lower alarm 
limit. 

 

Selecting “Enable upper alarm” enables the upper limit alarm. 
 
The limit is then displayed to the top right of the number. 

 
Selecting “Enable lower alarm” enables the lower limit alarm. 
 
The limit is displayed to the bottom right of the number. 
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Selecting “Change color” allows you to change the color of the 
number. 

 
Selecting “Change function” allows you to display another number. 

 
Selecting “Clear” clears the number field.  
 



 

6895 rev F  Laerdal Medical 2002 page 116 of 126 

6.4.2 Selecting a Number for an Empty Number Field 
If no number is selected for the touched number field, the menu for 
selecting a new number will appear. 

 
 

6.4.3 NIBP Menu 
The “NIBP,” Non Invasive BP, menu has two additional 
menu items. The monitor simulates a NIBP 
measurement by quickly increasing the numbers and 
then slowly decreasing them until the systolic and 
diastolic numbers are reached. 
 
(Note that during this process the actual cuff on 
SimMan’s arm does not inflate). 

 
Selecting “Start measurement” starts an NIBP measurement.  
Selecting “Change interval” allows you to change the intervals at 
which the monitor performs an automatic measurement.  

 

 

6.5 Alarms 
The SimMan Monitor alarm works by the “numbers.” 
Once a limit is enabled, the monitor continuously checks 
to see if the number exceeds that limit. If a limit is 
exceeded, three things happen. 

 

1. The alarm sounds from the pulse beeper of the link 
box. (Unless “Disable alarm sounds” is selected from the 
setup menu.) 
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2. The alarm window flashes a text message describing 
the cause of the alarm.  
3. The exceeded limit is highlighted and starts flashing. 

 
The student can then acknowledge the alarm by pressing 
the “Alarm disable” button. The alarm is then temporarily 
disabled, and the text turns white and stops flashing. A 
timer appears to the right of the text counting down the 
“Alarm re-engage time.” When it reaches zero, the alarm 
is activated again. 

 

When other alarm limits are broken simultaneously, the 
first non-acknowledged alarm will be shown. If all alarms 
are acknowledged, the alarm with the most time left (last 
acknowledged) will be shown. 

 

 

7 Updating Manikin, Link and Monitor Software 
The SimMan Manikin, Link and Monitor Software can be updated 
through a separate program. 
Make sure the SimMan program is not running when you start the 
“Update Manikin Software” through the Windows “Start” button. 
 
 
Select the desired target: Link, Manikin or Monitor. 
 
Select the PC “Serial Port” used to connect the Link: 
COM1, COM2 or COM3. 
 
The Link (and Monitor, if selected) must be powered 
on. 
 
Click “Start” to begin downloading. 
 
 

 
 
 
During download, the LED indicator on the Link will be 
turned off. 
 
The progress bars will indicate progress of download. 
 

 
 
The Manikin, Link and Monitor programs, “man.hex” and 
“alink.hex” and CEMonitr.exe must reside in the 
/SimMan folder. 

NOTE: 
- Switch off power to the Monitor when updating 

Link or Manikin Software 
- Always have power on the Link box when 

updating the Monitor Software 
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Appendix 
I. SimMan Directory Structure 

The root of the SimMan directory structure is the “SimMan” folder. All other folders of the SimMan 
software are related relative to this folder. 
 
The location of the SimMan folder is determined during installation. The default location is 
“C:\Program Files\Laerdal Medical\SimMan.” 
 

a. Overview 
 
These are the most important sub folders in the SimMan folder. 
 
Application – Folders the SimMan main program and Scenario 
Builder and Event Handler Editor uses. 
 
Profiles – Folder where all files belonging to particular SimMan 
users are located. 
 
Sounds – Where all vocal sounds are stored. 
 
 

 

b. SimMan Users 
Before starting SimMan, you must log in as a user. A folder with 
its own name is created in the “Profiles” directory for each user. 
When a new user is created, the files and folders in the “default” 
folder are automatically copied into the new user’s folder. 
 
The “default” folder is created during installation and contains the 
originally supplied Scenarios, Trends, Events, Menus, etc. 
 
Note: After a software upgrade, the “default” folder has been 
upgraded with new scenarios, but the other user folders have not. 
See below for instructions on copying new scenarios from the 
“default” folder to other user folders. 
 

c. First StartUp After Software Upgrade 
When the software is upgraded with a new version, any new scenario, trend or handler 
files are only installed into the “default” user. The first time SimMan Software is started, it 
will give you the option to copy the new files to all existing SimMan users. 
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This dialog box is only shown once, so unless you prefer to copy these files manually, you 
should answer “Yes.” 
 
Once “Yes” is selected, the program will automatically copy all new files from the “default” 
user to all other users. If an existing file with the same name as a new one exists,,this 
message is displayed: 
 

 
 
You must consider whether the user has made changes to the file he will want to keep. If 
you answer “Yes,” the old file will be overwritten with the new one. 
 

d. How to Import / Export Scenarios and Trends from / to Other Folders 
There are two cases when you might want to manually copy files into the right folders to 
ease usage. 

1. You want to copy a scenario/trend from another SimMan user on the same PC. 
2. You want to copy a scenario/trend from another SimMan user on another PC. 

 
Both cases are very similar. You must save the files into the respective user’s folder in the 
“profile” folder. See Directory Structure Overview above, the user “StaaleH” has his own 
folder in the “profile” directory, with subfolders for the various file types. Locate the correct 
user and copy the files into the correct folder. 
 
Note: Scenario and Handler files contain all Trends, Events and Sounds used by the 
Scenario / Handlers. Therefore, it is not necessary to copy those files when copying a 
scenario. 
 
Be particularly careful when copying the files in the “menus” directory, they will overwrite 
the Event Menu changes you have made. You should not need to copy these files when 
copying a scenario or handler. Both scenarios and handlers have customizable menus. 
See 4.6 and 5.8. 
 
After upgrading, new files will need to be copied from the “default” folder to each existing 
user’s folder. This is not done automatically to prevent user-modified files from being 
unintentionally overwritten. 
 
 

e. How to Edit the Default Frame0 of a Scenario 
When you create a new scenario, it does always starts with a default frame0 that sets the 
state of the Manikin. If you are continually editing this frame, you can instead change it for 
future scenarios by opening the Scenario Editor, browsing to the “template” folder, and 
opening the DefaultFrame0 scenario. 
 



 

6895 rev F  Laerdal Medical 2002 page 121 of 125

II. SimMan Program Files Overview 

a. PC Programs 
 
SimMan consists of these PC programs: 
Name Function Filename 
SimMan main program The main program the instructor 

uses to control the training 
session. 

SimMan.exe 
SimMan\Application folder 

SimMan host program Handles communication with 
the Manikin, Link box, and the 
Monitor. 

Hs3kHost.exe 
SimMan folder 

Scenario editor Edits scenarios. ScenarioEditor.exe 
SimMan\Application folder 

Event handler editor Edits the event handlers. EventHandlerEditor.exe 
SimMan\Application folder 

SimMan update program Updates the Manikin, Link box, 
and Patient Monitor. 

SimManUpdate.exe 
SimMan folder 

 

b. Other Programs 
In addition, there are separate programs for the Manikin, Link box, and the Patient Monitor. These 
programs are located in the respective units, but they can be updated using the SimManUpdate 
program. The files must be located in the same folder as the SimManUpdate program. 
 
Program name Filename 
SimMan Manikin program Man.hex 
SimMan Link box program Alink.hex 
SimMan Patient Monitor program CEMonitr.exe 
 

c. Program Communication Problems 
The programs need to communicate with each other for the SimMan system to work. Sometimes they 
will not for various reasons. 
 
The SimMan host program communicates with the external 
devices. It is normally hidden, but it can be opened from the 
system tray on the Taskbar found at the bottom of the PC 
screen. Double-click on the “ECG-Heart” icon. 
Once opened, the program displays a dialog which gives a 
good indication of communication status between the external 
devices and the PC. 
 
“Connected clients” displays the number of PC programs that 
have connected to it. SimMan’s main program, Scenario 
Builder and the Handler Editors can make a connection. It is 
not possible to close this program while the count is greater 
than zero. 
 
The “Manikin” is green if the connection with the Manikin is 
OK, otherwise it is red. 
 
The dialog also displays the external device version numbers 
and a colored square to the left of them. The colored square is 
green if the software version is ok, red if it is out dated, or gray 
if it has not made a connection. 
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At startup, the SimMan host program tries to 
determine to which COM port the Link box is 
connected. It first tries the last successful COM 
port, but if it does not get a reply it will display 
this message. 
“Abort” will close SimMan. 
“Ignore” continues without connecting to the 
external devices. 
“Retry” makes the program try the same port 
again. If a connection is still not found, an 
additional retry will make the program scan 
COM ports 1 through 9. 
In some cases, other PC programs have occupied the COM port to which the SimMan is connected. 
We have experienced problems with programs that are used to communicate with personal organizers. 
The COM port may also be disabled if the IR-port is enabled on a laptop. 
These problems are program specific or hardware specific to some programs and some PCs. Consult your 
program vendor or hardware vendor for solutions. 
 
In other cases, the SimMan main 
program has problems 
communicating with the SimMan 
host program. This dialog will 
appear. 

The SimMan main program uses TCP/IP to communicate with the SimMan host program. 
In Windows 95, TCP/IP was not installed by default; it is in newer Windows versions. 
A personal firewall, used to protect your PC from intrusion through the internet, may also block 
communication between the SimMan main program and host program by default. The personal firewall must 
be configured to allow these two programs to communicate locally on the same PC. This has nothing to do 
with a firewall that is running external to the PC. Such a firewall will never cause problems for SimMan. 
Contact your personal firewall vendor for configuration instructions. 
We have observed that a personal organizer synchronization programs may also cause this error. If you get 
this error and have such a program, attempt to disable it. 
 

III. Factors that Influence Head Speaker Sound Quality 
There are two issues regarding sound quality, sound volume and noise. They are somewhat 
interrelated. To get a good result, the recording of the sound has to be good and the playback must 
be optimized. 

a. Recorded Sound Quality 
It is not possible to get good quality from a poorly recorded sound. Recording a new sound may 
sound easy, but there are a few things you should consider. You must have a good microphone, it 
doesn’t have to be expensive. You must also think about echo from the walls of the room and noise 
from the environment. 
 
Most important, is the volume of the recorded sound. If the volume is too low, the playback volume will 
also be low. SimMan only has limited sound volume gain. If sounds are recorded at very high volume, 
the recorder will have to clip the highest volume peaks, which add a lot of noise. The optimum is to 
record the sounds at the highest possible volume, without the recorder ever having to clip. 
 
To set the recording volume using the standard Windows volume control, double click the speaker 
icon in the system tray found on the task bar. (Note: The symbol may be temporarily hidden if you are 
running Windows XP, unhide it by clicking the “<” button.) The “play control” dialog will appear, go to 
options, properties and select to adjust the volume for recording. (Ensure that the microphone control 
is enabled.) When the microphone volume control displays, select it and you are ready to go. 
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A smart tip here is to go to the SimMan “Tools menu” and select “Mic controls.” Select “Activate 
Microphone Amplifier” and deselect it again. Now you can adjust the microphone recording volume by 
adjusting “Mic in.” 
 
You cannot visualize the recorded volume of a sound using the Windows “Sound recorder” program. 
We recommend using another program, such as Goldwave (www.goldwave.com), but there are many 
other inexpensive programs. 
 
The speaker in the Manikin are not able to reproduce low frequency signals in the sounds, but still 
these low frequency signals influence the sound quality. It is therefore recommended that the low 
frequency signals become filtered from the sounds. Signals with a frequency of lower than 150 Hz 
should be filtered away. Goldwave can perform this task. Apply a Highpass filter with a cutoff 
frequency of 150 Hz. 
 

b. Sound Playback Optimization 
The big issue regarding playback is volume control. Sound volumes that are too low cannot be heard 
well. Sound volumes that are too high cause distortion. If the volume optimized to its maximum level, 
as described below, still is too low for your needs, you will need to purchase a set of PC speakers with 
an external power supply and connect them to the speaker output and place them as close to the 
Manikin head as possible. 
 
Vocal sounds are played back using the Windows sound system. There is also an amplifier in the Link 
box. The volume control beside the sound selection list in the SimMan program, adjusts this amplifier. 
Since SimMan uses the PC and Windows sound system for playback, their volume controls also 
influence the playback volume. The SimMan program sets the Windows output volume to about 80% 
at startup. Some laptops also have a physical volume control for the speaker output. 
 
The Windows “Play Control” controls the Windows output volume and can be accessed by double 
clicking the speaker icon on the task bar. The overall slider to the left and the wave slider control the 
volume. You can also adjust these two sliders in parallel by going to the SimMan “Tools menu” and 
selecting “Mic controls.” Deselect “Activate Microphone Amplifier” if you don’t need it. Now you can 
adjust the two volume levers by adjusting the “Master out.” 
 
Warning: If the output volume from the PC is too high, the Link box amplifier will become overloaded 
switch itself off. You will clearly hear this; almost no sound will be coming out of the speaker. If this 
happens you must reduce the Windows sound level. 
Distortion in speaker sound will be caused if the total level is too high. You will have to adjust it to a 
level acceptable to you. 
 

IV. SimMan XML Event Log Format 
The reports are stored in XML format. XML stands for extended Markup Language and is thought of 
as an extension to HTML, Hyper Text Markup Language, although XML is quite different and is not 
handled in the same way. 
HTML is the format used on the Internet to format and display text and pictures. XML is used on the 
Internet as a common text language for transferring data. 
The advantage of using XML to store the logs is that the logs can later be processed in different ways. 
It is possible to customize how the logs are displayed and it is also possible to import the data into a 
database that recognizes XML. 
Together with the log files having the “xml” extension, there are two other needed file types for 
processing the logs. First you have the XML schema file called “SimManLogSchema.xsd.” This file 
describes the data types used in the SimMan log files. The other file types are the XML Style Sheets, 
these files describe how the log files are displayed and have the “xsl” extension. The process of 
utilizing a style sheet to display a log file is called parsing. The SimMan program print log performs 
this process when printing a log. The user then selects which style sheet to use and the printout looks 
different based on his / her choice. 
 
Note: If you want to save the log as it is printed, you can save the log when it is displayed in the 
browser during the print process. The log is then saved in HTML format. As mentioned above, this 
format contains layout information. 
 
SimMan customers are free to customize the log print format or import the log data into the database 
of their choice; however, this requires expertise in XML. SimMan currently only supports the printing 
of those formats listed in the print dialog and is currently not supporting any particular database. 
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V. Available ECG rhythms 

a. Adult Rhythms 
QRS 
type 

Basic 
rhythms 

 Premature complexes Hear
t 
rates

Blood pressure Pulse strength 

  Pacing Unifocal  PVC 
Std / RonT 

Coupled 
PVC 

Multifoc. 
PVC  

PAC PJC Default Rates Default Blood pressures Default Strengths 

A-G Sinus  X X X X X X 80 10, 12, 14, … 
120, 124, … 
140, 145, … 
160, 170, 180,190,200 

120/80 Systolic max 300 
Diastolic max 210 

normal normal 
weak 
absent 

A-G A. tach.  X X X 180 90 (2:1), 140 (MAT), 150, 
160, 170, 180, 200, 220, 
240 260 

100/70 Systolic max 300 
Diastolic max 210 

normal normal 
weak 
absent 

A-G A. flutt.  X X X 100 75, 100, 150 120/80 Systolic max 300 
Diastolic max 210 

normal normal 
weak 
absent 

A-G A. fib.  X X X 160 30 (3°blk), 50, 60, 70, 80, 
90, 100, 110, 120, 140, 
160, 180, 200 

120/80 Systolic max 300 
Diastolic max 210 

normal normal 
weak 
absent 

A-G Junct.  X X X  50 30, 50, 60, 70, 80, 100, 
110, 120, 140, 160 

120/80 Systolic max 300 
Diastolic max 210 

normal normal 
weak 
absent 

A-G Idiov.  X X X 40 10, 20, 30, 40, 50, 60 100/70 Systolic max 300 
Diastolic max 210 

normal normal 
weak 
absent 

A-G V. tach X  180 120, 140, 160, 180, 200, 
220, 240  

70/40 Systolic max 300 
Diastolic max 210 

weak normal 
weak 
absent 

N/A Torsades des 
Pointes 

  200 200 70/40 Systolic max 300 
Diastolic max 210 

weak normal 
weak 
absent 

None V. fib. 
Very Coarse 

  N/A N/A 0/0 N/A absent absent 

None V. fib. 
Coarse 

  N/A N/A 0/0 N/A absent absent 

None V. fib. 
Standard 

  N/A N/A 0/0 N/A absent absent 

None V. fib. Fine   N/A N/A 0/0 N/A absent absent 
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None V. fib. 
Very Fine 

  N/A N/A 0/0 N/A absent absent 

None Asystole   N/A N/A 0/0 N/A absent absent 

None Agonal  
Rhythm 

      N/A N/A 0/0 N/A absent absent 

None Ventricular 
Standstill 

      N/A N/A 0/0 N/A absent absent 

A-G 1o AVB  X X X X X 80 10, 20,30, 40, 50, 60, 70, 
80, 90, 100, 110, 120, 140, 
160 

120/80 Systolic max 300 
Diastolic max 210 

normal normal 
weak 
absent 

A-G 2o AVB #1 X X X X 60 50 (5:4), 60 (4:3), 75 (3:2) 
 

110/80 Systolic max 300 
Diastolic max 210 

normal normal 
weak 
absent 

A-G 2o AVB #2 X X X X 60 60, 70, 90  100/70 Systolic max 300 
Diastolic max 210 

normal normal 
weak 
absent 

A-G 3o AVB X X X X 40 30, 50Wide complex QRS) 
60 (Narrow complex QRS) 

70/40 Systolic max 300 
Diastolic max 210 

weak normal 
weak 
absent 

N/A Pacemaker     80 Atrial Pacemaker  120/80 Systolic max 300 
Diastolic max 210 

normal normal 
weak 
absent 

N/A Pacemaker     80 AV sequential pacemaker, 
pacing the atrium and the 
ventricle (A-V interval 
0.15sec) 

120/80 Systolic max 300 
Diastolic max 210 

normal normal 
weak 
absent 

N/A Pacemaker     80 Ventricular Pacemaker. No 
atrial activity. 

120/80 Systolic max 300 
Diastolic max 210 

normal normal 
weak 
absent 

N/A Pacemaker     80 Ventricular Pacemaker. 
Atrial (P) rate = 90. 

120/80 Systolic max 300 
Diastolic max 210 

normal normal 
weak 
absent 

N/A Pacemaker     100 Ventricular Pacemaker. 
Atrial (P) rate = 90. 

120/80 Systolic max 300 
Diastolic max 210 

normal normal 
weak 
absent 

N/A Pacemaker     80 Ventricular Pacemaker. 
Atrial fibrillation. 

120/80 Systolic max 300 
Diastolic max 210 

normal normal 
weak 
absent 

N/A Pacemaker     80 Loss of capture 120/80 Systolic max 300 
Diastolic max 210 

normal normal 
weak 
absent 

 




